# Table of Contents

**Introduction** ................................................................. 1
  - What’s New In Totality 3.0? ............................................ 1
  - Summary Of Features .................................................. 6
  - Installation .................................................................. 9
  - Registering And Upgrading .......................................... 13
  - Money Back Guarantee ................................................ 15
  - Options ....................................................................... 15
  - Navigator .................................................................... 23
  - Toolbar ........................................................................ 24
  - Menu ........................................................................... 26
  - Keyboard And Shortcut Keys ........................................ 26
  - How To Use Help ........................................................ 28
  - File Utilities ............................................................... 29

**Concepts and Definitions** ................................................. 31
  - Overview Of Abacus Totality ........................................... 31
  - Contingency Fees .......................................................... 34
  - Allocation Method .......................................................... 36
  - Automatic Payment Holds ............................................. 38
  - Interest Start Date .......................................................... 39
  - Date Judgment Entered .................................................. 39
  - Judgment Amount .......................................................... 39
  - Placement Amount ........................................................ 39
  - Remarks ....................................................................... 40
  - Drop-Down List/Arrow .................................................... 40
  - Working With Dates ....................................................... 41
# Table of Contents

**Tutorial**
- ABACUS TOTALITY Users Guide

**Claim Details**
- New Claim Window .................................................. 58
- Summary Tab................................................................. 60
- General Tab................................................................. 60
- History Tab................................................................. 61
- Financials Tab............................................................... 63
- Court Tab................................................................. 64
- Remarks Tab............................................................... 65
- Auxiliary Claim Information.......................................... 66

**Transactions**
- New Transaction Window............................................. 67
- Transaction Detail........................................................ 69
- Transaction Types List.................................................. 70
- NSF Button............................................................... 72

**Lists**
- Lists Window............................................................. 73
- Debtors List.............................................................. 74
- Clients List............................................................... 79
- Creditors List........................................................... 81
- Other Lists............................................................... 82

**Searches**
- Searching In Totality................................................... 91
- Search For Claims....................................................... 92
- Search For Ticklers...................................................... 94
- Search For Debtors...................................................... 95
- Search For Transactions............................................... 96

**Ticklers**
- Add New Tickler......................................................... 97
- Tickler Details............................................................ 100
- Tickler Examples......................................................... 100
- Ticklers List (Summary Tab)......................................... 101
Reports ................................................................. 103
  Print Preview Window .................................. 103
  Claim Report ............................................. 103
  Statement Of Account .................................. 105
  Reports Window ....................................... 106
  Transaction Report .................................... 107
  Payment Report ........................................ 111
  Tickler Report .......................................... 114
  Exporting To Other Programs .................. 115

Mail Merge ...................................................... 116
  How To Export Data To Use In A Mail Merge .... 116
  How To Perform A WordPerfect Mail Merge ...... 117
  How To Perform A Microsoft Word Mail Merge . 118

Troubleshooting .................................................. 121
  Solving Problems You May Encounter With Totality: .... 121
  Technical Support ...................................... 123

Appendix ............................................................ 125
  Network Installation .................................. 125
  Peer-To-Peer Networks .............................. 133
  Upgrade To Network Version .................... 138
  Upgrading Totality 2.1 Database to 3.0 ............ 145

Index .................................................................... 147
What’s New In Totality 3.0?

Totality version 3.0 contains all of the features and functionality of previous versions and adds a revised interface and a variety of new features and reports. Here are some of the changes and new features in Totality 3.0:

Upgrading Totality 2.1 Database to 3.0

Totality 3.0 comes with a database conversion program, which will convert your Totality 2.1 database to 3.0.

See also: For instructions on converting your 2.1 database see page 145.

Y2K Compliant

Totality 3.0 is fully Year 2000 compliant and will operate properly throughout the 21st century.

Easier Data Input

Totality 3.0 makes it a lot easier and faster to enter cost and payment transactions. Instead of opening each claim and going to the Financials Tab, now you can enter all your transactions for all your claims from the New Transaction window.

Multiple Debtor Addresses, Employers And Assets

Totality 3.0 enables you to enter and track multiple addresses, employers and assets for debtors. You can easily specify which address or employer is the current one.
Ticklers Are Listed Within Claims
When you open a claim you now can see all the ticklers that are associated with that claim.

Automated Claim History
Totality 3.0 contains an automated claim history, which allows you to create and maintain a chronological record of all the events associated with a claim. Totality can also automatically produce a tickler when you create a history entry of a specified type.

Reports
Totality 3.0 retains all of the reports from previous versions and adds many new reports.

- You can now print a report of any of the many lists in the program, including lists of all claims meeting specified criteria, debtors, clients and creditors.
- The Custom Report and Claim Report from earlier versions have been combined into a single customizable Claim Report.
- When printing a Transaction Report or Payment Report, you can now select which clients will be included in the report. Use the Report Client Selection window to select just a single client, several clients or all the clients. Clients appear in that window only if they are associated with claims containing transactions within the date range you specified.

New Search Capability
In addition to being able to search for claims and ticklers, Totality 3.0 also enables you to search for transactions and debtors.

32-Bit Program
Totality 3.0 is a 32-bit program and runs only on 32-bit Windows operating systems, including Windows NT 4.0 (SP4 or higher),
Windows 98 and Windows 95. As a 32-bit program, Totality 3.0 includes all of the standard 32-bit features, including:

- Tool tips, which allow you to determine the function of most icons, buttons or data fields by moving your cursor there and holding it for about one second. That will cause a tool tip to appear stating the function of that icon, button or field.
- Right-click menus, which allow you to copy, cut or paste text between editable data fields anywhere in the program.
- Clickable list headers, which enable you to change the sort order of the many lists in the program.

**International Compatibility**

You can configure Totality 3.0 to work in the United States, Canada or other countries. Telephone numbers, postal (Zip) codes and other data will be optimized for the specified country.

**New Lists**

In addition to the lists of debtors, clients, creditors, status codes and transaction types used by earlier versions, Totality 3.0 also contains a number of new lists. This makes it easier for you to enter data, makes data input errors less likely and enables you to sort data by any of these list criteria. The new lists include:

- **Attorneys**: This is a list of names, addresses, phone numbers and other information about the attorneys representing debtors and, if you are a collection agency, representing you or your clients.
- **Counties**: This is a list of all the counties where debtors reside and where you have filed suit against debtors.
- **States and provinces**: This list is used by all of the address windows in Totality. The program ships with a complete list of all the states, provinces and territories of the United States and Canada.
Countries: This list is used by all the address windows in Totality and is directly tied to the new mask option feature, which ensures international compatibility of phone numbers and postal codes.

**Toolbar And Shortcut Keys**
Totality 3.0 adds a toolbar and shortcut keys to enable you to quickly access the most commonly used features from anywhere in the program at any time.

**New Leap Year Option**
Now you have the choice of having the program calculate on the basis of 360, 365 or 366 days (if a leap year) in a year.

**Auxiliary Claim Information Windows**
In addition to all the data fields available for inputting information in connection with every claim, Totality 3.0 contains three additional Auxiliary Claim Information windows. Two of the windows are in name and address format, and the third allows you to enter additional data in whatever format you like.

**Enhanced On-Line Help**
Totality 3.0 has an improved on-line help system to make it even easier for you to obtain information about any part of the program:

- Virtually every window in Totality 3.0 contains a new Help button, which will open a help window with information about the window you are viewing.
- Pressing the F1 function key opens a help window containing information about the field the cursor is in.
- The on-line help contains not just a table of contents and a comprehensive index but also a Find tab, which enables you to search for any word or phrase contained anywhere in the help file.
Multiple Database Names And Locations
You can use multiple Totality 3.0 databases, and the database files can have any name you choose (with an MDB extension) and can be located in any folder on any accessible drive.

Enhanced Network Capabilities
Totality 3.0 has enhanced networking capabilities, which make the program easier to use and more stable on local area networks.
Summary Of Features

Abacus Totality is the easy Windows program for managing a contingency fee collection practice. It is powerful enough to manage a large collection practice, and so easy to use that even attorneys who spend most of their time billing on an hourly basis can use Totality to build a profitable contingency fee collection practice.

Automatically Calculates Interest And Account Balances

While Totality allows the user to enter and keep track of a wide variety of information about collection accounts, perhaps its most useful feature is the ability to automatically calculate outstanding balances on collection accounts. All the user needs to do is enter the following information:

1. The principal amount owed by a debtor.
2. Any payments or costs on that account.
3. The applicable interest rate.
4. The priority of how payments are to be allocated between principal, interest and costs.

Totality automatically calculates the accrued interest on the account, the outstanding balance after each payment or cost, and how each payment is to be allocated between principal, interest and costs. If the account is being handled on a contingency fee basis, then once the contingency fee percentage is entered for a particular client, each payment is also allocated between the client’s or creditor’s share and the attorney’s or agency’s contingency fee.
Automatically Generates Documents In Word Or WordPerfect

Totality’s mail merge feature allows you to export collection data to Microsoft Word or Corel WordPerfect for Windows. This allows you to automatically generate word processing documents, such as demand letters and pleadings.

You can export data from Totality to WordPerfect versions 6.0, 6.1, 7, 8, 9, 10, and 11 and Word versions 6.0, 95 (also known as Word 7) and 97 (also known as Word 8), 2000, XP, and 2003.

You can also export your Totality data to any other program that supports mail merge.

EXAMPLE: By exporting your data to a spreadsheet, such as Microsoft Excel or Corel Quattro Pro, you can create customized reports.

Full-Featured Tickler System

Totality has a full-featured tickler system, allowing the user to set a tickler, or reminder, for any date. Every time the program is run, any ticklers scheduled for today or any previous day are automatically displayed. When Totality is run on a network each user has his or her own tickler queue.

Ticklers can be rescheduled on the fly, marked as complete or deleted. Totality maintains a database of all ticklers marked as complete so they can be accessed and reviewed at any time.

Ticklers can also be created automatically when you make an entry in Totality’s automated claim history.

Variety Of Reports

Totality produces a variety of reports, including detailed reports on individual debtors, statements of account, all transactions during a specified period of time, and all payments received during a specified period of time. Here are just some of the reports you can produce with Totality:
- The detailed Claim Report is a printout of all the information entered for a particular debtor. This provides a very useful hard copy that can be included in the debtor’s paper file or sent to a client. You can customize the Claim Report by selecting which information will appear in the report.

- The Statement of Account is a listing of all payment and cost transactions for a particular debtor, including allocation between principal, interest and costs, and a running outstanding balance. These are useful for sending to debtors and for submitting to courts in connection with debtor lawsuits.

- The Transaction Report is a detailed listing of all transactions that occurred during a specified period of time. Although most users will want to produce this report at the end of each month, it can be run at any time and can include all transactions for any date range.

- The Payment Report is similar to the Transaction Report except that it lists only payments and does not list cost transactions.

You can also print a report of any of the many lists in the program, including lists of all claims meeting specified criteria, debtors, clients and creditors.

**Safeguards Against NSF Checks**

To safeguard against debtor checks that are returned for non-sufficient funds (NSF) or on which payment is stopped, Totality allows the user to put an Automatic Hold on specified debtor payments. If a Transaction Report or Payment Report is run during the hold period, then the held payments will not appear on the report. Once the hold period has expired, those payments will appear on future reports.

**Automated Claim History**

Use Totality’s automated claim history to create and maintain a chronological record of all the events associated with a claim.
Totality can also automatically produce a tickler when you create a History Action of a specified type.

**Network Ready**
Totality can be run either on a standalone computer or on a network.

**Unlimited Number Of Debtor Accounts**
Unlike some other collection programs, there is no limit to the number of debtor accounts you can enter and track in Totality.

**Built-In Backup, Repair And Compaction Utilities**
As with any other database program, it is critical that you backup your database frequently—ideally once a day. Totality contains three file utilities to make it easier for you to backup your data and keep it working properly. These utilities are available from the File menu at the top of the screen and allow you to backup, compact and repair your database.

**International Compatibility**
You can configure Totality to work in the United States, Canada or other countries. Telephone numbers, postal (Zip) codes and other data will be optimized for the specified country.

**Installation**

**System Requirements**
Totality runs under any 32-bit version of Microsoft Windows, including Windows 95, Windows 98, Windows NT 4.0 (SP4 or greater), Windows 2000, and Windows XP. (Totality will NOT run under Windows 3.1, Windows for Workgroups (Windows 3.11) or any version of MS-DOS.) We recommend a minimum of a
Pentium 200 with 32Mb RAM. The program itself requires approximately 10 to 40 megabytes (10-40 MB) of hard drive space (depending upon whether any of the needed files already exist on your computer.) Totality is written in Microsoft Visual Basic 6 and uses a Microsoft Access 97 database file to store information. The database file is initially about 600KB and grows in size with the number of claims and transactions.

**Single User Installation**

Installing Totality on a single computer is very simple. Just insert the Totality CD-ROM in your CD-ROM drive, run SETUP.EXE and follow the on-screen instructions.

Totality will run in trial mode for 100 days after you first install it. After 100 days the program will no longer run until you register the program by entering registration codes obtained from Totality Software, Inc. Registration codes can be entered at any time, either before or after the 100-day period expires.

**NOTE:** The single user version of Totality cannot be run across a network, even if only a single workstation will be accessing the database at a time. To run Totality across a network you must have the network version.

To upgrade to the network version call Totality Software, Inc. at (858) 536-8077.

See also: For instructions on how to register Totality see page 136.

**Network Installation Overview**

Totality can be installed on two different types of local area networks (LANs) -- networks using a dedicated server (which is not used as a workstation) and peer-to-peer networks where all of the connected computers are used as workstations but one computer holds shared data files.
The installation procedure for the two different types of networks is different. Be sure to use the correct procedure for your type of network.

For instructions on installing Totality on a dedicated server network, such as Windows NT 4.0 Server or Novell NetWare, see page 125 in the Appendix.

For instructions on installing Totality on a peer-to-peer network, such as Windows NT 4.0 Workstation, Windows 98 or Windows 95, see page 133 in the Appendix.

**Users Window**

If you are running Totality on a local area network, then this window contains the list of the user names and full names for all the people who are authorized to use the program.

This window can only be accessed by the network administrator logging in using the “admin” user name. This window is not visible to other network users or when Totality is running on a single computer.
How To Access

The Users window can be accessed by the following methods:

- Click on the Edit menu and then select “Users”
- Press Control-U
- Click the Users button on the Navigator

Resetting Passwords

If any of your users have forgotten their password, the administrator can reset that user’s password to the same as his or her user name by selecting their name on the left side of the window and then clicking the Reset Password button.

EXAMPLE: If David Marlow with a user name “david” forgets his password, highlight his name on the left side of this window and then click the Reset Password button. His password will be reset to “david.”

Changing Passwords

Passwords cannot be changed on this window. Any user can change his or her own password by following the instructions on this window. In brief, click the File menu, select “Change Password,” and follow the instructions on the Change Password window, which looks like this:
WARNING: Totality passwords are not encrypted or otherwise secured. Although passwords cannot be viewed from within the program, an experienced computer user may be able to determine the passwords for other users.

NOTE: Passwords are not case sensitive.

Changing “Admin” Password
If you change the password for the “admin” user from the default “admin” and later forget the new password, you will be unable to access the Options or Users windows. If this occurs, contact Totality Software, Inc. for assistance.

Registering And Upgrading
Totality will run for 100 days unregistered, at which time you must enter registration codes in order to continue running the program. You’ll need to enter new registration codes to upgrade from Totality Lite to Totality (Totality includes the mail merge feature, whereas Totality Lite does not), or to upgrade from the single user version of Totality to the network version, or to increase the number of users licensed to run Totality on your network.

NOTE: For network installations you only have to enter registration or upgrade codes once, from either the server or from any workstation.

1. To register or upgrade your copy of Totality, click the Register/Upgrade button on the Navigator to open the Register/Upgrade window.
2. Contact Totality Software, Inc. to obtain registration codes. Either call (858) 536-8077 or send e-mail to support@TotalitySoftware.com.

3. Tell the representative or include in your e-mail the Code Entry Number and Computer ID displayed in the Register/Upgrade window.

4. You will be given a Trigger Code and, if you are running on a network, an Additional Number. Enter the Trigger Code and, if applicable, the Additional Number in the corresponding fields on the Register/Upgrade window.

5. Click the Enter Registration Codes button to complete your registration or upgrade. You should automatically return to the Navigator. If you decide not to complete the registration/upgrade process, click the Close Without Changes button.

6. To confirm that Totality is correctly registered, click the Help menu and then select “About Abacus Totality”:

   - If you are a single user, the About Totality window should say “Totality” in large bold letters.
   - If you are a network user, the About Totality window should say “Totality for Local Area Networks” in large bold letters, and just above that it should tell you the number of “LAN
Licenses“ you are authorized and the number of “Current LAN Users.”

- If, in either case, the About Totality window says “Totality (TRIAL MODE),” then you are not correctly registered or configured. Try repeating these steps one more time.

**Money Back Guarantee**

Totality comes with a 100-100 guarantee—if you are not completely satisfied with Totality, you can get 100% of your money back (not including shipping and handling) for 100 days, so long as the program has not yet been registered. You also receive 100 days of free technical support.

By registering Totality, you are agreeing that you find the program satisfactory, but your free technical support continues for 100 days after you purchased Totality, regardless of when you register the program.

**Options**

**Options Windows**

These windows allow you to change various settings that apply throughout the Totality. You can access the Options windows by the following methods:

- Click the Options button from the Navigator
- Click the Options icon on the toolbar (second icon from the right for network administrators and single users)
- Click the Edit menu at the top of every screen, then select “Options”

**NOTE: The Options windows cannot be accessed by network users (other than the administrator logging in as user “admin”).**

There are six Options windows:
• Report Header
• Interest Rates
• Contingency Fees
• User Type
• Leap Year Option
• Mask Option

Report Header
This window is where you enter the firm name that will be printed at the top of your reports.

![Report Header Window](image)

Interest Rate Defaults
Enter the pre-judgment and post-judgment interest rates that will apply to new claims. The rates you enter will appear in the New Claim window when you create a new claim.

If you want a different pre- or post-judgment interest rate to apply to one or more claims, change them on the General Tab for those claims.
Contingency Fee Defaults

The contingency fees entered on the Options windows Contingency Fee Defaults tab will be the default fees when you create a new client.

The default fees can be overridden for a particular client on the Clients List Contingency Fee tab (accessed from the Lists menu) or for a particular claim on the Claim Details General tab.

See also: For more information about how Totality uses contingency fees see page 31.
User Type

Totality can be configured for use by either law firms or collection agencies. The selection is made on the User Type window, which is part of the Options windows.

If you configure Totality for collection agencies, the following changes are made:

1. **GENERAL TAB:** The Creditor field and Plus button are disabled because collection agencies enter creditor information in the Client field and list.

2. **SUMMARY AND GENERAL TABS:** “Attorney Claim Number” is changed to “Agency Claim Number.”

3. **CLIENTS LIST:** “Attorney Client Number” is changed to “Agency Client Number.”

4. **FINANCIALS TAB:** On the transactions column headings and in corresponding reports, “Attorney” is changed to “Agency,” and “Agency” is changed to “Client.”

5. **LISTS MENU:** “Creditors” will not appear.

6. **LISTS WINDOW:** The Creditors button will not appear.

7. **NAVIGATOR:** The Creditor button will not appear in the New column.
8. TOOLBAR: The Creditors List icon will not appear.

Leap Year Option
You have three choices about how to have interest calculated. You can choose to have Totality calculate interest based on a 360-day year, a 365-day year or have leap years calculated as a 366-day year.

Using a 360- or 365-day year is simpler and may make it easier for other people (such as court clerks) to verify interest calculations. However, these are less accurate and will result in more than one year’s interest being calculated for a one-year period that includes a leap year (such as January 1, 1996 through January 1, 1997).

360-DAY OPTION: Totality will assume that every year has 360 days. The interest calculations will never be completely accurate because more than one year’s interest will be calculated for every year. This option is simpler than the 366-day option and may make it easier for other people (such as court clerks) to verify interest calculations.
365-DAY OPTION: Totality will assume that every year has 365 days. Interest calculations will be completely accurate in non-leap years, but more than one year’s interest will be calculated for leap years. This option is simpler than the 366-day option and may make it easier for other people (such as court clerks) to verify interest calculations.

366-DAY OPTION: Totality will assume that non-leap years have 365 days and leap years have 366 days. Interest calculations will be completely accurate at all times, but they will be more difficult to verify manually.

NOTE: The 365- and 366-day options give the same results except for periods that include all or part of a leap year.

Mask Option
Totality allows you to apply three different types of masking to postal (Zip) codes and phone number fields:

United States Mask
If you select the United States mask, then postal codes can only consist of 5- or 9-number Zip codes and phone numbers can
only consist of a 3-digit area code, 7-digit phone number and an optional extension. When you create a new address, the country field will default to United States.

**Canada Mask**

If you select the Canada mask, then postal codes can only consist of 6-character postal codes and phone numbers can only consist of a 3-digit area code, 7-digit phone number and an optional extension. When you create a new address, the country field will default to Canada.

**International Mask**

If you select the international mask, then postal codes and phone numbers can consist of any combination of numbers and letters. When you create a new address, the country field will be blank by default.

**NOTE:** When entering a new address, if you select a country other than the United States or Canada then the international mask—that is, no masking—will automatically apply.

The mask option you select will apply to any phone numbers and postal codes for new debtors, clients, creditors and attorneys. You can change the type of mask option for any specific address by selecting a different country in the Country field.
The Navigator gives you direct access to nearly every part of Totality. This is the first window you will see when you first run Totality, and it is the first window you will see each subsequent time you run Totality (unless you have uncompleted ticklers scheduled for that day or a prior date, in which case the Ticklers Search window will be displayed first).

**Accessing The Navigator**

You can always access the Navigator, even if you inadvertently close the Navigator window. Simply click on the Help menu and select “Navigator.” If the Navigator is open but is hidden by other windows, you can get back to it by clicking the Window menu and selecting “Abacus Totality Navigator.”

**Buttons Vary**

A few of the buttons that appear in the Navigator vary, depending upon what version of Totality you are running and how you are logged in:
• If you are running the network version of Totality and are logged in as the administrator (user “admin”), you will see all the buttons, as in the screen shot above.

• If you are running the single user (non-networked) version of Totality, you will see all the buttons except the Users button. That is because single users logon and logoff automatically when they run and exit the program and do not need user names or passwords.

• If you are running the network version of Totality and are logged in as a user other than the administrator, you will see all the buttons except the Options and Users buttons. That is because only the network administrator can change the program options and view or edit user names.

• If you are running Totality Lite you will see all the buttons except the Mail Merge and Users buttons. That is because Totality Lite does not contain the mail merge feature and does not use user names or passwords.

**Toolbar**

The toolbar is the strip of icons, or small pictures, at the top of every screen in Totality, just below the menu.

Here is a list of the toolbar icon functions, from left to right:

• Log in (only appears in the network version)
• Log out (only appears in the network version)
• New claim
• Search for claims
• New transaction
• Mail merge
• Search ticklers
• New tickler
• Backup database
• Compact database
• Repair database
• Transaction report
• Payment report
• Tickler report
• Debtors list
• Clients list
• Creditors list (only appears when User Type is set to “Law Firm”)
• Options (only appears in single user version and for network administrator)

Icons Vary
A few of the icons that appear in the toolbar vary, depending upon what version of Totality you are running and how you are logged in:

1. If you are running the network version of Totality and are logged in as the administrator (user “admin”), you will see all the icons, as in the above screen shot.

2. If you are running the single user (non-networked) version, you will see all the icons except the first two on the left (logon and logoff). That is because single users logon and logoff automatically when they run and exit the program.

3. If you are running the network version of Totality and are logged in as a user other than the administrator, you will see all the icons except the Options icon (second from right). That is because only the network administrator can change the program options.
Tool Tips
You can determine what any of the toolbar icons do by moving your cursor to an icon and holding it there for about one second. That will cause a tool tip to appear stating that icon’s function.

Menu
The menu appears at the top of every screen in Totality.

Most of the functions on the menu are also accessible from the Navigator, the toolbar and various windows in the program. Specifically, all of the functions on the Activities, Reports and Lists menu can be accessed from the Navigator and other windows. However, some functions, such as the functions on the Files menu, are only accessible from the menu or toolbar.

Keyboard And Shortcut Keys
Totality generally uses standard Windows keystrokes for moving around and between screens and for activating buttons and menus, such as the following:

- **TAB:** Moves from one field to the next field or moves the highlight (focus) from one button to the next button.
- **SHIFT-TAB:** Moves from one field to the previous field or moves the highlight (focus) from one button to the previous button.
- **ALT-letter:** Activates any button which has that letter underlined. For example, on the Navigator ALT-C is the same thing as clicking the Claim button to create a new claim, and ALT-D is the same thing as clicking the Debtor button to
create a new debtor. ALT-letter can also access the menus on the menu bar (just below the navy blue title bar at the top of the screen). Pressing the Alt key and then pausing a fraction of a second activates the menu bar, and you can then press the underlined letter in any of the menus to go to that menu.

ENTER: Activates whatever button is highlighted on the screen. For example, when you first go to the Navigator the Claim button is highlighted, and so pressing Enter will take you to the New Claim window.

ESCAPE: If you have a dialog box or help screen displayed, pressing the Escape key will usually close the box or screen and return you to the screen you had previously been viewing.

ESCAPE, ESCAPE: If you ever appear to be stuck at any place in Totality and can’t get to anywhere else in the program, pressing the Escape key twice in a row will often clear the problem.

Shortcut Keys
Totality also uses shortcut keys to access frequently used features. All of the items on the Activities menu have shortcut keys, and the shortcuts are listed on the Activities menu next to the menu items that they correspond to. In addition, Totality uses all of the standard Windows shortcut keys, such as CTRL-C (Control key and “C”) to copy text and CTRL-F4 to close a window.

Here is a list of all the non-standard shortcut keys and their functions:
How To Use Help

Totality contains comprehensive on-line help for all aspects of the program, and you will probably find it easier and faster than this printed Users Guide. The easiest way to find help is to go to the window in Totality that you need help with and then click the Help button. (You can also click the Help menu and then select "Help for this Window" or click the Help icon on the toolbar.) Any of those methods will open a help window with information about the window you are on. At the bottom of that help window you may see topics listed under “See Also”. These will further assist you in learning about Totality or how to accomplish a specific related task.

If you click on any data field in Totality and then press F1 you will get help about that field.

Jumps And Pop-Ups

Throughout the help windows for Totality you will see some words or phrases in green type. Some of the words and phrases will be solidly underlined, and others will be dotted underlined.
The green type means that you can click once with your mouse on the word or phrase to get more information on that topic. The solid underline means that you will jump to a new help screen discussing the underlined word or phrase; the dotted underline means that a definition or discussion of a related topic will “pop-up” on your screen.

**Screen Shots And Hot Spots**

Most of the help topics include screen shots of Totality windows. Many of those screen shots contain “hot spots.” Click on any of these hot spots to get information about that portion of the window shown in the screen shot.

**NOTE: You can recognize a hot spot because your cursor turns into a hand when it passes over a hot spot.**

**File Utilities**

There are three file utility programs available from the File menu at the top of every screen. These utilities allow you to back up, compact and repair your database.

**Back Up**

We recommend that you back up your database at least once a day. Ideally, you should back up all your data daily using a tape back up system. By default, all of the data you enter in Totality is contained in a file called Totality 3.0.MDB, which is located in your C:\Abacus Totality\Database directory (folder). (The database file name and location can be changed.)

In addition, you can use Totality’s back up utility to back up your Totality database to:
1. Another computer on a network
2. Another hard drive or Zip drive on your computer
3. A diskette, if your TOTDATA.MDB file is no more than 1.4MB in size, or
4. Another directory (folder) on your hard drive.

We recommend that you back up to another directory (folder) on your hard drive only if none of the other options are available because if your hard drive fails then you would lose both your working database and your backup copy.

**Compact**

We recommend that you compact, or shrink, your database once or twice a month. This will reduce the size of your database file and can improve performance. You should always backup your database before using the compact utility.

**Repair**

If you encounter any problems or error messages running Totality, we recommend that you first backup your database and then run the repair utility. In most cases this will solve your problem. After you backup and repair the database we recommend that you also compact it.
Overview Of Abacus Totality

Abacus Totality operates around the concept of a “claim.” A claim is an amount of money owed by a “debtor” to a “creditor.” A debtor can be either an individual or a company. A creditor is normally a company, such as a bank or merchant, but it can also be an individual, such as a doctor or accountant. Typically, the creditor has lent money or provided services to the debtor, and the debtor has failed to pay all or part of the money it owes to the creditor.

When a law firm uses Totality, a “client” may also be associated with a claim. The client is typically a forwarder or collection agency that has retained the law firm to collect a claim from the debtor. In other words, the creditor assigns a claim to a collection agency, and the collection agency is the law firm’s client.

If a law firm is representing a creditor directly (that is, if no collection agency is involved), or if a collection agency is using Totality, then the creditor and the client are the same and they are both described as the “client.”

Claim Details Window

The heart of Totality is the Claim Details window. Every claim has a Claim Details window, which consist of six “tabs” containing all of the information pertaining to that claim. All six tabs appear at the top of each Claim Details window.
When you create or work on a claim, you will be working on one or more of the tabs on the Claim Details window. Most of the information on these tabs is optional, that is, you can enter information if you want to, but it’s not mandatory. However, certain information must be entered or else Totality will not calculate correctly. Field labels in red indicate this mandatory information.

To create a claim, you must enter certain information on the New Claim window, such as the placement (principal) amount owed by the debtor, the interest rate to be charged on the principal balance both before and after judgment is entered, the date from which interest starts being calculated, and the debtor’s first and last names.

Once you have entered this mandatory information, you can start entering cost and transaction payments on the Financials Tab, which is where you will probably spend most of your time working with Totality.

**Creating Debtors, Clients And Creditors**

When you create a claim you must enter information about a debtor, client and (optionally) creditor. There are two different ways of entering this information:

**Lists**

Before you create a new claim, you can enter information for a new debtor, client or creditor from the Lists window, which is accessed from the Navigator. The names you enter on the lists will appear in the drop-down lists on the corresponding fields when you subsequently create a claim.

**EXAMPLE:** If you go to the Debtors list and create a new debtor named John Smith, then when you create a new claim and click
on the drop-down error in the Debtor field, you will see John Smith (actually, “Smith, John”) listed. Alternatively, you can just start typing “Smith, John” in the Debtor field, and that debtor’s name will be automatically filled in.

“On The Fly”
If you are creating a new claim involving a debtor, client or creditor which you have not previously created, you can type the new name directly in the corresponding field in the New Claim window. When you leave that field by tabbing or clicking in another field, Totality will automatically open a list window for the new debtor, client or creditor. You can enter more detailed information at this time, such as address and phone number, or you can enter it later. When you are done with the list window, click Save and then Close, which will return you to the New Claim window.

Reports
After you have entered information about a claim, you can print reports that will include some or all of that information. There are three categories of reports: (1) reports on a single claim, (2) reports on all the claims with transactions within a specified period of time and (3) reports on any of the lists in the program, including a list of all claims meeting specified criteria.

Reports on a Single Claim: There are two reports you can print for a single claim—the Claim Report and Statement of Account. To select one of these reports, click the Reports button on the bottom of the Claim Details window, which opens the Single-Claim Reports window. These reports will print information about whatever claim you are viewing when you run the report.

Reports on Multiple Claims: There are three reports you can print for multiple claims—the Transaction Report, Payment Report and Tickler Report. These reports are created from the Reports window, which is accessed from the Navigator.
All reports can be previewed on-screen and printed on your printer.

See also: Wherever you are in Totality, help for the window or field you are working on is always available by pressing the F1 key. You can also get on-line help by clicking the Help button on most windows or accessing the Help menu at the top of the screen.

Here are some additional sources of help:
For a tutorial to help you get started with Totality see page 43.

### Contingency Fees

The contingency fee is the percentage of each debtor payment that is kept by the attorney as his or her fee for collecting the debt. (If you are a collection agency, then the contingency fee is the percentage that you keep for collecting the debt.)

Unless the contingency fee is accurate then the program will not calculate correct amounts for the attorney and agency fee. If a contingency fee is not applicable to a claim, then enter 0% in the contingency fee field.

Totality uses the contingency fee for calculating the attorney’s fee and agency fee for each payment. These figures appear on each payment transaction line on the Financials Tab and reports. (If "Collection Agency" rather than "Attorney" is selected as the User Type then the contingency fee will be used in calculating the agency fee and client fee.)

### Entering Contingency Fees

There are three places in Totality where you can enter contingency fees:
- Contingency Fee Defaults window, accessed from the Navigator Options button—the contingency fees entered here will be the default fees when you create a new client.
• Clients List Contingency Fee tab (accessed from the Lists menu) -- the contingency fees entered here will be the default fees when you create a new claim for that client.

• Claim Details General tab -- the contingency fees entered here will be the fees used for calculating attorney and agency fees for that claim.

**Sliding Scale Fees**

By default there is a flat-rate contingency fee for each claim (such as 33.33%). However, if the Sliding Scale box is checked then you can enter sliding scale contingency fees up to a maximum of ten levels. By default, the sliding scale is the Commercial Law League rates, but these can be changed to any rates.

**NOTE:** If you use a sliding scale contingency fee, the entry in the Amount column on the final line must be “Remainder.” To insert “Remainder” on the last line, click the drop-down arrow to the right and select “Remainder.”

**Default Fee**

When you create a new client the contingency fee you select will be the default contingency fee for all new claims associated with that client, and that contingency fee will appear on the General Tab for each associated claim. You can change the contingency fee for a particular claim on the General Tab without affecting the default contingency fee for any new claims associated with that client.

**NOTE:** If you want a new contingency fee to be applied to existing transactions, you will have to enter those transactions a second time as new transactions.
How To Change A Client Contingency Fee

To change the contingency fee for all new claims associated with a client, follow these steps:
1. Go to the Navigator.
2. Click the Lists button, which opens the Lists Window.
3. Click the Clients button, which opens the Clients List.
4. Select the client you want.
5. Click on the Contingency Fee tab.
6. Click the Edit button.
7. Change the contingency fee.
8. Click the Save button.

NOTE: This change will not affect the contingency fee on any existing claims associated with that client. If you change the contingency fee, or any of the numbers in a sliding scale contingency fee, for a particular claim, it will affect only new transactions; any existing transactions will not be affected.

See also:
For information on changing the default contingency fee for new clients see page 17.

Allocation Method

This field determines the order in which payments are allocated between principal $P$, interest $I$ and costs $C$. This is a critical decision because the amount of interest charged against the debtor—and, therefore, the debtor’s balance—is directly affected by the allocation method chosen.

The default allocation method is CIP. That means that payments are allocated first to costs, then to interest and finally to principal. This maximizes the amount of interest that will be incurred on the claim because the principal amount, upon which the interest is
calculated, does not begin to decrease until after all the costs and interest have been satisfied.

If you want to change to a different allocation method, click on the down arrow and select a different allocation method from the drop-down list. Allocating payments to principal before interest will result in a lower balance where payments are made over time, and a smaller amount of payments will be sufficient to pay off the balance for a given interest rate.

When you create a new client, the allocation method you select will be the default allocation method for all new claims associated with that client, and that allocation method will appear on the General Tab for each associated claim. You can change the allocation method for a particular claim on the General Tab without affecting the default allocation method for any new claims associated with that client.

**NOTE:** The allocation method that is selected on the General Tab will also appear on the Financials Tab.

**How To Change A Client's Allocation Method**

To change the allocation method for all new claims associated with a client, follow these steps:

1. Go to the Navigator.
2. Click the Lists button, which opens the Lists window.
3. Click the Clients button, which opens the Clients List.
4. Select a client from the Clients List.
5. Click on the Contingency Fee tab.
6. Click the Edit button.
7. Change the allocation method by clicking the drop-down arrow to the right of the Allocation Method field and selecting the method you want.
8. Click the Save button.
NOTE: This change will not affect the allocation method on any existing claims associated with that client.

**Automatic Payment Holds**

Totality will automatically put a hold on specified payments. Typically, this feature is used with checks received directly from debtors, such as personal or business checks. Totality will automatically hold such payments for the specified number of days from the transaction date (that is, the date entered on the transaction line on the Financials Tab) to allow time for the check to clear.

If a Payment Report or Transaction Report is run during the hold period, then the held payment will not appear in the report. After the hold period expires, if one of those reports is run and the report includes the date the hold expired, then the held payment will appear in the report.

**EXAMPLE:** If a held payment is entered dated October 25 and the hold period is 10 days, and if a Payment or Transaction Report is run on October 31 with a date range October 1 through October 31, then the held payment will not appear in that report.

The hold on that payment expires November 4. If a report is run on November 30 with a date range November 1 through November 30, then the held payment will appear on that report because the hold expiration date falls within the selected date range.

Please note that even if a held payment does not appear in a Payment or Transaction Report, the balances shown for any subsequent costs or payments on the report do reflect that held payment.

If one of the single-claim reports (Claim Report or Statement of Account) is run during the hold period, then the held transaction will appear the same as any other payment except that the letter “H” will appear in the left margin. Similarly, held payments appear on the Financials Tab just like any other payment.
For the step-by-step procedure on how to create an automatic hold see page 71.

**Interest Start Date**

This is the date from which interest on the Placement Amount is calculated. It is not necessarily the same as the Date Assigned.

THIS IS A MANDATORY FIELD. Unless the Interest Start Date is accurate, then all pre-judgment account balances and interest calculations will be incorrect.

**Date Judgment Entered**

This is the date judgment was entered against the debtor. This date automatically supersedes the Interest Start Date for the purpose of calculating post-judgment balances and interest.

THIS IS A MANDATORY FIELD (if a judgment has been entered). Unless the Date Judgment Entered is accurate then all post-judgment account balances and interest calculations will be incorrect.

**Judgment Amount**

This is the total amount of the judgment entered against the debtor, including any interest, costs and attorney fees. This amount automatically supersedes the Placement Amount for the purpose of calculating post-judgment balances and interest.

THIS IS A MANDATORY FIELD (if a judgment has been entered). Unless the Judgment Amount is accurate then all post-judgment account balances and interest calculations will be incorrect.

**Placement Amount**

This is the amount that was originally placed for collection with the forwarder or attorney. This amount is used by Totality for calculating account balances and interest until a judgment amount and entry date are entered.
THIS IS A MANDATORY FIELD. Unless the Placement Amount is accurate then all pre-judgment account balances and interest calculations will be incorrect.

Remarks

The Remarks fields allow you enter any remarks or comments you want to keep about the window in which it appears.

This field appears in several windows throughout Totality, including the following:

- Court Tab
- Remarks Tab
- New Claim window
- Debtors list General, Address, Assets and Employers tabs
- Clients list Remarks tab
- Creditors list Remarks tab
- Attorneys list Remarks tab

Although you can use the remarks fields to maintain a chronological history of some or all of the actions taken in connection with the claim, you may find it easier to use the automated History Tab for that purpose.

Drop-Down List/Arrow

A drop-down list is a method of inputting data into a data field. You can tell a drop-down list is available for a particular field if there is a downward-pointing arrow to the right of the field (the drop-down arrow).

You can access the drop-down list by clicking on the drop-down arrow, and the list will pop up. If the list is long, there will be a scroll bar on the right side of the list. You can move up and down the list using either the cursors or the mouse. When you find the data you want click on it or else highlight it and then press Enter.
Instead of popping up the list you can alternatively start typing in the data field. As you type, the data will automatically fill in the data field. When you see the data you want press Enter.

Working With Dates

Totality contains a number of date fields in which you are allowed, or in some cases required, to enter a date. Examples of date fields are the Interest Start Date and Date Assigned fields in the New Claim window.

This is what a date field looks like:

![Date Field Example](image)

Entering Dates

There are three ways to enter or change dates:

- Type the date on the keyboard.
- Select the month, day or year in the date field (by clicking on them) and then click the up or down arrows to increase or decrease the selected month day or year.
- Access the calendar by clicking the large down arrow.
To select a date on the calendar, simply click on it. To move to a different month or year:

**Changing Months**

To change the month, click the left or right arrows. Clicking the left arrow decreases the month, and clicking the right arrow increases the month.

**Changing Years**

To change the year, click the horizontal scroll bar between the arrows. Clicking the left side decreases the year, and clicking the right side increases the year.

To change the year more rapidly, drag the scroll box (the square on the horizontal scroll bar). Dragging to the left decreases the year, and dragging to the right increases the year.
The following steps will get you started using Totality. If you are running the network version, you can perform all the steps in this tutorial only if you are logged in as the “admin” user, which uses the password “admin” unless you have changed it. If you are logged in as a different network user, you can perform all of the steps except 1 through 10.

ALWAYS REMEMBER: to get help from any place in Totality just press the F1 key.

1. When you first start Totality you will see the Navigator. The Navigator gives you direct access to nearly every part of Totality. This is the first window you will see when you run Totality. Click the Options button (or press ALT-O).
2. You are now at the Options windows. This is where you select various options for how Totality is going to run. To change any of the options (which are described below), you first need to click the Edit button, and to save your changes you need to click the Save button.

3. The first window is the Report Header window, where you enter the name of your company or firm. The name you enter here will be printed at the top of your reports.

4. Click on the Interest Rate Defaults tab. This opens the Interest Rate Defaults window, where you enter the pre-judgment and post-judgment interest rates that will apply to new claims. The rates you enter will appear on the New Claim window and General Tab when you create a new claim. If you want a different pre- or post-judgment interest rate to apply to one or more claims, change them on the New Claim window or General Tab for those claims.
5. Click on the Contingency Fee Defaults tab. This opens the Contingency Fee Defaults window. The contingency fees entered here will be the default fees when you create a new client.

6. Click on the User Type tab. This opens the User Type window, where you specify whether Totality will be used by a
law firm or by a collection agency. If you select “Collection Agency,” several changes are made throughout the program.
See page 18 for details.

7. Click on the Leap Year Option tab. This opens the Leap Year Option window, where you can choose to have Totality calculate interest based on (1) a 360-day year, (2) a 365-day year or (3) a 365-day year for non-leap years and a 366-day year for leap years.
8. Click on the Mask Option tab. This opens the Mask Option window, where you can select among three different types of masking for postal (Zip) codes and phone number fields. Whichever option you select, it can be overridden on any address window by selecting a different country for the address in that window.
9. You have now completed setting all your options. After clicking Save or Cancel, click the Close button (or press ALT-C), which returns you to the Navigator.

10. If you are running the network, click the Users button (or press CTRL-U or click the Edit menu and select “Users”). This opens the Users window, where you can add, edit and delete the user names and reset the passwords of the people who will be running Totality on your network.

A. If you haven’t already, enter the names of all the people who will be running Totality on your network. The initial passwords will be the same as the user names you create. For example, if John Smith’s user name is “jsmith,” then his password will be “jsmith” unless and until he changes it via the File menu Change Password window.

B. When you are done entering users, click the Save button, then click the Close button (or press ALT-C), which returns you to the Navigator.
11. Click the Lists button (or press ALT-L or click the Lists menu).

12. You are now at the Lists window. This is where you create and edit Totality’s ten lists. Before you start creating new claims, you may prefer to enter information about the debtors, clients, creditors and attorneys associated with those claims. To do so, click on the Debtors, Clients, Creditors or Attorneys buttons, as necessary.

**NOTE:** If you do not enter this information now, you will have the opportunity to enter it “on the fly” when you create new claims.

Totality comes with sample Status Codes, Transaction Types and History Actions already entered in corresponding lists. If you want to edit the sample data, click on the corresponding buttons. Totality also comes with lists of several southern California Counties, all of the States, Provinces and territories in the United States and Canada, and several Countries. All of these also can be edited as you wish. (If you want to replace the names of the states, provinces and territories with the official two-letter abbreviations, the help file contains a list of those abbreviations.)

13. When you are done reviewing and editing lists and have returned to the Lists window, click the Close button (or press ALT-C), which returns you to the Navigator.
14. Now you are ready to begin doing real work with Totality. In the New column on the Navigator, click the Claim button, which opens the New Claim window. (For a list of other ways to open the New Claim window, and for step-by-step instructions on how to create a new claim, see page 58.)

15. Enter the claim information on the New Claim window, being sure to include the mandatory information indicated by the red labels. When you are done, click the Save button.

16. If you want to enter more information about this claim, click the Details button on the bottom of the New Claim window. This opens the claim and allows you to access the Claim Details window.

**NOTE: Only enter information on the Court Tab if suit has already been filed on a claim.**

17. When you are done entering claim information, click on the Financials Tab, where you can begin entering payment and cost transactions for the new claim. To do so, click the Add button on the right side of the Financials Tab.
18. Alternatively, you can enter transactions for any claim on the New Transaction window. For instructions on how to open this window see page 68.

19. At any point you can print reports on the claims you have entered by clicking the Reports button on the Claim Details
window for that claim and then clicking the Claim Report or Statement of Account buttons.

20. At any point you can create a tickler in connection with the open claim by clicking on the New Tickler button on the Claim Details window. You can also create new ticklers for unopened claims from the Add Tickler window—for instructions see page 99.

21. To view a list of all ticklers associated with a particular claim, open that claim; the list appears on the Summary Tab.
22. When you are done entering new claims, return to the Navigator. You can always access the Navigator, even if you inadvertently close the Navigator window. Simply click on the Help menu and select “Navigator.” If the Navigator is open but is hidden by other windows, you can get back to it by...
clicking the Window menu and selecting “Abacus Totality Navigator.”

23. To print a Transaction Report, Payment Report or Tickler Report, click the Reports button (or press ALT-R), which opens the Reports window. Then click the button for the report you want.

NOTE: To print a Transaction Report or Payment Report you need to enter the beginning and ending dates of the report. All transactions (or for the Payment Report, all payments) occurring between those dates will be included in the report.

24. When you are done printing and previewing reports, click the Close button to return to the Navigator.

25. In addition to searching for ticklers, Totality has separate windows to search for claims, debtors and transactions. All of these search windows can be accessed from the Activities menu under “Search,” and the Search Claims windows can also be opened by clicking the Search for Claims button on the Navigator.

NOTE: On all of the search windows, clicking the Search button without specifying any search criteria produces a list of all of the items in the list (all the claims, debtors or transactions).
The Search Debtors window is useful if you have a large number of debtors in the Debtors List. In addition to searching by first and last names (or company name), you can also search by Social Security number and phone number.

The Search Transactions window searches all of the transactions from all of the claims in the program. Among the criteria you can...
search for are check number, transaction amount, debtor name and claim number.

26. To export your Totality claim data to Microsoft Word or Corel WordPerfect to generate demand letters, pleadings and other word processing documents, click the Mail Merge button (or press ALT-M). Select the claim or claims you want to export. When you have completed selecting claims, click the Export button. Your data will be exported to a data file that your word processor will use to merge data with your documents.

**NOTE:** The mail merge function is not available in Totality Lite. If you purchased Totality Lite you can obtain the mail merge function by upgrading to Totality. For information call Totality Software, Inc. at (858) 536-8077.
27. CONGRATULATIONS! You have completed the Totality tutorial! You are now prepared to work in any area of the program. And remember—help is always available by pressing the F1 key.

See also:
For an overview of Totality see page 18.
For a listing of what's new in Totality 3.0 see page 1.
For help using Totality's on-line help see page 28.
New Claim Window

This window is where you create a new claim. The fields labeled in red are mandatory and must be completed in order to save the claim. Once you have saved the new claim, you may click the Details button, which opens the Claim Details windows, where you can enter any additional information involving the new claim.

How To Create A New Claim

1. New claims are created in the New Claim window, which can be accessed by a variety of methods:
   - On the toolbar, click the New Claim icon (first icon on the left for single users, third icon from the left for network users)
   - On the Navigator, click the Claim button in the New column
• On the menu, select Activities, New, Claim
• On the Search Claims window, click the New Claim button
• On any of the Claim Details windows, click the Add button
• Press the F3 function key on the keyboard from anywhere in Totality

2. If the debtor is a company, click on the radio button (circle) next to the word “Company.” (The default selection is “Individual,” and so if the debtor is an individual skip this step.)

3. If you want to create a new claim as quickly as possible with only the minimum amount of data, fill in the fields with red labels, which are mandatory. (For more information about any of the fields, click on that field on the screen shot below.) The fields with black labels are optional.

4. When entering debtor, client or creditor names, you may enter either a name that already exists on the corresponding Debtors, Clients or Creditors list or you can enter a new name. If you enter a new name, when you tab or mouse click to the next field the corresponding list window will automatically open so that the new debtor, client or creditor can be added to that list. Enter whatever additional information you wish about the new entity. Then click the Save button followed by the Close button.

5. When you have finished entering data in the New Claim window, click the Save button.

6. If you want to enter additional information about this claim, click the Details button, which gives you access to the Claim Details windows.
Summary Tab

This window summarizes some of the most important current information about the claim. This is the first window you will see when you open a claim.

Except for the ticklers, the information on this window cannot be edited here; it is a copy of information entered and edited on other tabs:

- The Debtor Name, Claim Number and Status are from the General Tab.
- The balance and payment information are from the Financial Tab.

If you want to edit any of those fields, go to those tabs and click the Edit button.

General Tab

This window is where you view, enter and edit basic information about the claim. You must be in edit mode to edit or enter any information. To enter edit mode click the Edit button.
History Tab

The claim history allows you to maintain a chronological history of all the activity associated with a claim.

A history entry consists of a date, an action (which is a summary of the activity being entered) and, optionally, remarks (a more detailed description of the event). The actions are created and edited in the History Actions list.
**What Are History Actions?**

History Actions are the different types of activities that typically occur during the collection process.

Totality ships with a list of sample History Actions. You are free to use, edit or delete these actions, and you may create your own History Actions.

**Automatic Ticklers**

When you create History Actions in the History Actions list, you can choose to have a tickler automatically created for a specified number of days after certain History Actions are entered on the History Tab. When you add and save an entry for such an action, the Add Tickler window will automatically appear.

If you want to use the automatic tickler, complete the tickler Action field, make any necessary changes and click the Save button.

If you do not want to use the automatic tickler, click the Cancel button and then the Close button, which will return you to the History Tab.

**Sorting History Entries**

The history entries are automatically sorted in chronological order. Click the Action header to sort the entries in alphabetical order by Action.

**How To Create A History Tab Entry**

To add a new entry to the History Tab, follow these steps:

**Using An Existing Action:**

1. Click the Add button on the right side of the History Tab.
2. In the Date field, enter the date that the action occurred.
3. In the Action field, select an action from the drop-down list.
4. In the Remarks field, you may enter any details or comments about the entry.

5. Click the Save button.

6. If the action you selected had an automatic tickler associated with it, the Add Tickler window will open. You can either complete adding the tickler or cancel the tickler.

**Creating A New Action:**

1. Click the Add button on the right side of the History Tab.

2. In the Date field, enter the date that the action occurred.

3. Click the Plus button to the right of the Action field, which opens the History Actions list.

4. Enter the new action. If you want an automatic tickler to be associated with this action, enter the number of days after the action that the tickler should appear.

5. Click Save and then OK.

6. In the Remarks field, you may enter any details or comments about the entry.

7. Click the Save button.

8. If the action you selected had an automatic tickler associated with it, the Add Tickler window will open. You can either complete adding the tickler or cancel the tickler.

**Financials Tab**

This window is where you enter and view payments received and costs incurred. This window also shows how each payment is allocated, the current balance of the account and the balance for any specified date.

The fields that appear on the Financials Tab vary depending upon whether or not judgment has been entered. The screen shot
below is of a Financials Tab for a claim on which judgment has not been entered.

You can use the horizontal scroll bar at the bottom of the window (just above the buttons) to move to the far right side of the transaction lines. That will allow you to see the following additional calculations about the transactions:

- Allocations between principal, cost and interest.
- Contingency fee allocations between attorney and agency fees.
- Balance as of the date of the transaction.
- The interest rate applied to each transaction.

<table>
<thead>
<tr>
<th>Date</th>
<th>Description</th>
<th>Type</th>
<th>Amount</th>
<th>Check No / Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>07/23/1979</td>
<td>Cash payment</td>
<td>P</td>
<td>$100.00</td>
<td></td>
</tr>
<tr>
<td>07/25/1979</td>
<td>Check payment</td>
<td>P</td>
<td>$150.00</td>
<td></td>
</tr>
<tr>
<td>08/15/1979</td>
<td>Summons/Complaint serve</td>
<td>C</td>
<td>$250.00</td>
<td></td>
</tr>
<tr>
<td>08/15/1979</td>
<td>Check payment (held)</td>
<td>P</td>
<td>$250.00</td>
<td></td>
</tr>
</tbody>
</table>

**Court Tab**

This window is where you enter, edit and view information about the lawsuit that has been filed on the claim. You must be in the Edit mode to edit or enter any information. To enter the edit mode click the Edit button.
Remarks Tab

This window allows you enter any remarks or comments you want to keep about the claim.

Although you can use this window to maintain a chronological history of all the actions taken in connection with the claim, you may find it easier to use the automated History Tab for that purpose.
Auxiliary Claim Information

The Auxiliary Claim Information windows allow you to enter claim information that does not fit in any of the other Claim Detail tabs. (You can also enter miscellaneous information in the Remarks Tab).

There are three Auxiliary Claim Information windows, two for people (Person 1 and Person 2) and one for any other type of information (Auxiliary Information).
New Transaction Window

This window is where you enter or create new transactions. The New Transaction window can be accessed by a variety of methods:

- On the toolbar, click the New Transaction icon (third icon on the left for single users, fifth icon from the left for network users and administrators)
- On the Navigator, click the Transaction button in the New column
- On the menu, select Activities, New, Transaction
- Press the F6 function key on the keyboard from anywhere in Totality
- On the Financials Tab, click the Add button on the right side

How To Create A New Transaction

You can create a new transaction from the Financials Tab of an open claim or from elsewhere in Totality.

From The Financials Tab:
1. Click the Add button on the right side of the Financials Tab. This opens the New Transaction window.
2. The Debtor Name/Claim Number field will automatically contain the debtor name and claim number of the open claim. If you want to enter a transaction for a different claim, select the claim number/debtor name you want from the drop-down list.
3. Use the Tab key or the mouse to move to the Transaction Date field and enter the date of the transaction. The default is today’s date, but it can be changed to any other date on or after the Interest Start Date.

4. Use the Tab key or the mouse to move to the Transaction Amount field. Enter the amount of the transaction.

5. Use the Tab key or the mouse to move to the Transaction Type field. Select a transaction type from the drop-down list or click the Plus button to create a new transaction type.

6. If you wish, use the Tab key or mouse to move to the Check Number/Notes field. You can optionally enter the number of a check or other brief notes about the transaction.

7. Click the Save button or press Alt-S to save the transaction.

8. To enter another transaction click the Add button or press Alt-A. To return to the Financials Tab click the Close button or press Alt-C.

From Elsewhere In Totality:
1. Open the New Transaction window by one of the following methods:
   - Click the New Transaction icon on the toolbar (third icon from the left for single users, fifth icon from the left for network users)
   - Click the Transaction button in the New column on the Navigator
   - On the menu, select Activities, New, Transaction
   - Press the F6 function key on the keyboard

2. In the Debtor Name/Claim Number field, select the claim number/debtor name for this transaction from the drop-down list. You can either click the drop-down arrow and select a claim from the list or you can start typing the last name or company name of the debtor.
3. Use the Tab key or the mouse to move to the Transaction Date field and enter the date of the transaction. The default is today’s date, but it can be changed to any other date on or after the Interest Start Date.

4. Use the Tab key or the mouse to move to the Transaction Amount field. Enter the amount of the transaction.

5. Use the Tab key or the mouse to move to the Transaction Type field. Select a transaction type from the drop-down list or click the Plus button to create a new transaction type.

6. If you wish, use the Tab key or mouse to move to the Check Number/Notes field. You can optionally enter the number of a check or other brief notes about the transaction.

7. Click the Save button or press Alt-S to save the transaction.

8. To enter another transaction click the Add button or press Alt-A. To close the New Transaction window, click the Close button or press Alt-C.

**Transaction Detail**

This window displays the details of a single transaction, including both inputted and calculated data.

The Transaction Detail window can be opened from either the Financials Tab or the Search Transactions window:

- On the Financials Tab, select (click on) a transaction and then click the Details button on the right side.
- On the Search Transactions window, select (click on) a transaction and then click the Details button on the bottom.

Either of these procedures opens the Transaction Detail window for the selected claim. If you click the **Edit button** you can change the date, amount, transaction type and check number/notes.
Transaction Types List

This window enables you to edit and view the list of transaction types and create new transaction types. After creating transaction types on this list, you select the applicable transaction type when entering transactions on the Financials Tab.

What Are Transaction Types?

Transaction types are the different types of transactions that can be entered on the Financials Tab. They consist of a description, a “type” (C, P or N) and, optionally, the number of days that type of transaction will be automatically held.

The descriptions can be selected when entering a cost or payment transaction on the Financials Tab. When a transaction description is entered in this list, it will appear in the drop-down list on the Financials Tab.

Each transaction in the Transaction Types list must be designated with “C” if it is a cost, “N” if it is a cost that is not to be charged to the debtor (non-chargeable cost), or “P” if it is a payment.
Totality ships with a list of sample transaction types. You are free to use, edit or delete these samples, and you may create your own transaction types.

**Automatic Hold**
You can choose to place an automatic hold on certain types of payments. This feature is most often used in connection with checks received from debtors. To place an automatic hold on a certain transaction type, type the number of days you want the payment to be held in the Hold Days field.

See also:
For more information about the automatic hold feature see page 38.

**How To Create An Automatic Payment Hold**
To create an automatic hold, follow these steps:
1. Go to the Navigator.
2. Click the Lists button, which opens the Lists window.
3. Click the Transaction Types button, which opens the Transaction Types List.
4. Select the type of transaction to be held (or create a new type of description to be held).
5. In the field labeled “Hold Days” enter the number of days you want that type of transaction to be held.

**SUGGESTION:** You may want to include the word “hold” or “held” somewhere in the description to help you identify held transactions on-screen and in reports.
NSF Button

The NSF button on the Financials Tab allows you to reverse a previous debtor payment that has been stopped or returned for non-sufficient funds (NSF).

To use the NSF button click on any part of the transaction line for the payment that was stopped or returned. Totality will add a new transaction line immediately above the stopped or returned payment. The new line will contain all the same numbers as the stopped or returned payment except that the numbers will be negative.

The date in the NSF transaction will be the same date as the stopped or returned payment. If you have already printed a Transaction Report or Payment Report, which included the original payment, then you may want to revise the date of the NSF transaction to today’s date so that the NSF transaction will be included in your next report. You may also choose to edit the description of the NSF transaction if you wish by selecting a different Transaction Type.
Lists Window

This window allows you to view and edit lists of all of the debtors, clients, creditors and status codes and other lists. You can also create new debtors, creditors, clients, status codes, etc. from this window.

NOTE: The screen shot below shows the Lists window when the User Type is set to “Law Firm.” If the User Type is set to “Collection Agency,” the Creditors button will not appear.
Debtors List

General Tab
This window is for entering, viewing and editing information about debtors and co-debtors. There are separate tabs for entering addresses and information about debtors’ employers and assets.

Viewing Debtor Information
To view information about an existing debtor, click on that debtor’s name in the list on the left side of the window.

Creating New Debtors
To create a new debtor, click the Add button on the bottom of the window. The only mandatory information for creating a new debtor (if the debtor is an individual) is the debtor’s last and first names.

If the debtor is a company, click on the Company radio button (the circle next to “Company”) before entering the debtor’s name. In this case, the only mandatory information for creating a new debtor is the company name.

Edit Mode
You must be in the edit mode to edit or enter any information. To enter the edit mode click the Edit button.
Address Tab
This window allows you to enter one or more addresses for the selected debtor.

Current Address
You can specify which address is current by putting a check mark in the “Current” check box. The current address will always be listed first.

Working With Addresses
The buttons on the right side of this window allow you to view, edit, create and delete addresses. The buttons on the bottom of the window are for viewing, editing, creating and deleting debtor listings.

Creating A New Address
To create a new address, click the Add button on the right side or press Alt- D. (Do NOT click the Add button on the bottom or press Alt- A; that will create a new debtor.)
When you are done creating a new address, click the Save button on the right side or press Alt-V.

**Viewing Addresses**
When you have more than one address entered for a debtor, you can access the addresses by using the top four buttons on the right side of the window.

**Assets Tab**
This window allows you to enter one or more assets for the selected debtor. An asset can be anything of value, including a bank account, stock, motor vehicle, jewelry or art.

**Working With Assets**
The buttons on the right side of this window allow you to view, edit, create and delete assets. The buttons on the bottom of the window are for viewing, editing, creating and deleting debtor listings.
Creating A New Asset
To create a new asset, click the Add button on the right side or press Alt-D. (Do NOT click the Add button on the bottom or press Alt-A; that will create a new debtor.) When you are done creating a new asset, click the Save button on the right side or press Alt-V.

Viewing Assets
When you have more than one asset entered for a debtor, you can access the assets by using the top four buttons on the right side of the window.

Employers Tab
This window allows you to enter one or more employers for the selected debtor.

Current Employer
You can specify which employer is current by putting a check mark in the “Current” check box. The current employer will always be listed first.
If the debtor currently has two employers (that is, if the debtor has two jobs), mark one as current and add a comment in the Remarks field for the other stating that this employer is also current.

**Working With Employers**

The buttons on the right side of this window allow you to view, edit, create and delete employers. The buttons on the bottom of the window are for viewing, editing, creating and deleting debtor listings.

**Creating A New Employer**

To create a new employer, click the Add button on the right side or press Alt-D. (Do NOT click the Add button on the bottom or press Alt-A; that will create a new debtor.)

When you are done creating a new employer, click the Save button on the right side or press Alt-V.

**Viewing Employers**

When you have more than one employer entered for a debtor, you can access the employers by using the top four buttons on the right side of the window.
Clients List

General Tab
This window is for entering, viewing and editing information about clients. There are separate tabs for entering contingency fee information and miscellaneous remarks.

What Is A Client
The client is usually an account forwarder, such as a collection agency, but it can also be a direct creditor for accounts where no forwarder is involved (or where the forwarder is using Totality). If you represent the creditor directly then you can enter the creditor information on both the Creditors list and Clients list or else you can elect to use just the Clients list.
Note that while you do not have to assign a creditor to a claim, you MUST select a client because the payment Allocation Method and contingency fee are associated with clients.

Viewing Client Information
To view information about an existing client, click on that client’s name in the list on the left side of the window.

Creating New Clients
To create a new client, click the Add button on the bottom of the window. The only mandatory information for creating a new client is the client’s name.

Edit Mode
You must be in the edit mode to edit or enter any information. To enter the edit mode click the Edit button.
Contingency Fee Tab
The contingency fees entered in this window will be the default fees when you create a new claim for this client.

See also: For more information about how Totality uses contingency fees see page 31.
Creditors List

This window is for entering, viewing and editing information about creditors. There is a separate tab for entering miscellaneous remarks about the creditor.

What Is A Creditor

A creditor is a person or company that is owed money by a debtor. If you represent a forwarder, such as a collection agency, then the creditor is the person or company to whom the debt was originally owed. If you are a forwarder, or if you represent the creditor directly, then the creditor is also your client.

If you represent the creditor directly then you can enter the creditor information on both the Creditors and Clients lists or else you can elect to use just the Clients list.

Note that while you do not have to assign a creditor to a claim, you MUST select a client because the payment Allocation Method and contingency fee are associated with clients.

Viewing Creditor Information

To view information about an existing creditor, click on that creditor’s name in the list on the left side of the window.

Creating New Creditors

To create a new creditor, click the Add button on the bottom of the window. The only mandatory information for creating a new creditor is the creditor’s name. When a creditor is entered in this window, that creditor’s name will appear on the drop-down list on the Creditor Name field on the New Claim windows.

Edit Mode

You must be in the edit mode to edit or enter any information. To enter the edit mode click the Edit button.
Other Lists

Attorneys List
This window is for entering, viewing and editing information about attorneys. There is a separate tab for entering miscellaneous remarks about the attorney.

Use Of Attorneys List
Although the Attorneys List is most commonly used for attorneys representing debtors, it can also be used to save information about any attorneys involved with the collection process, including attorneys representing forwarders, collection agencies or creditors and attorneys to whom claims are assigned for collection or legal action.

Once an attorney is entered on the Attorneys List, his or her name can be associated with a claim by selecting it in the Attorney(s) field on the Claim Details General Tab.

Viewing Attorney Information
To view information about an existing attorney, click on that attorney’s name in the list on the left side of the window.
**Creating New Attorneys**

To create a new attorney, click the Add button on the bottom of the window. The only mandatory information for creating a new attorney is the attorney's first and last name.

**Edit Mode**

You must be in the edit mode to edit or enter any information. To enter the edit mode click the Edit button.

![Image of attorney list](image)

**Status Codes List**

This window enables you to edit and view the list of status codes and create new status codes.

**What Are Status Codes?**

Status codes are brief summaries of the status of a claim. After creating status codes on the this list, you select the applicable status code for a claim on the General Tab. Whatever status code you select on the General Tab will also appear on the Summary Tab.
Totality ships with a list of sample status codes. You are free to use, edit or delete these codes, and you may create your own status codes.

**Closed Cases**
You can use status codes to mark cases as closed by putting a check mark in the “Closed” check box. This allows you to archive closed cases but to still have access to them in your Totality database.

If you select a “closed” status code on the claims detail General Tab, then Totality will treat that claim as being closed. When you search for claims on the Search Claims window, closed claims will not appear unless you select Yes or All on the “Closed” field.

One of the sample status codes Totality ships with is called “Case closed” and contains a check mark in the “Closed” check box.

**Sorting Status Codes**
The status codes are sorted in alphabetical order (or numerical order from 0 to 9). If you want to control the order of the Status Codes, you can insert a letter in front of each code and the codes will be sorted alphabetically, or you can insert a number in front of each code and the codes will be sorted numerically from 0 to 9.

Here’s an example of an alphabetic sort:
A. Claim received  
B. Demand letter sent  
C. Voluntary payments  
D. Complaint filed

**How To Create A New Status Code**
New status codes can be created in two different ways:

**From The General Tab Of An Open Claim:**
1. Click the Edit button.
2. Click the Plus (+) button to the right of the Status field, which opens the Status Codes List.

3. Click the Add button.

4. Enter the new Status Code and a Description. If this Status Code is to be associated with closed files, then place a check mark in the Closed check box.

5. Click the Save button.

6. Click the Close button to return to the open claim.

**From The Status Codes List:**

1. Go to the Navigator.

2. Click the Lists button, which opens the Lists window.

3. Click the Status Codes button, which opens the Status Codes List.

4. Click the Add button.

5. Enter the new Status Code and a Description. If this Status Code is to be associated with closed files, then place a check mark in the Closed check box.

6. Click the Save button.
History Actions List

This window enables you to edit and view the list of History Actions and create new History Actions.

What Are History Actions?

History Actions are the different types of activities that typically occur during the collection process. The actions in this list are used for making entries in the claim history, which is located on the History Tab on an open claim.

The claim history allows you to maintain a chronological history of all the activity associated with a claim. A history entry consists of a date, an action (which is a summary of the activity being entered) and, optionally, remarks (a more detailed description of the event). The actions are created and edited in this window.

Totality ships with a list of sample History Actions. You are free to use, edit or delete these actions, and you may create your own History Actions.
**Automatic Ticklers**
You can choose to have a tickler automatically created for a specified number of days after certain History Actions are entered. To do so, enter the number of days in the Tickler Days field on this window.

EXAMPLE: if you want to have a tickler created 30 days after you send a demand letter to a debtor, you could create an action called “Sent demand letter to debtor” and enter “30” in the Tickler Days field.

**Sorting History Actions**
The History Actions are sorted in alphabetical order (or numerical order from 0 to 9). If you want to control the order of the History Actions, you can insert a letter in front of each code and the codes will be sorted alphabetically, or you can insert a number in front of each code and the codes will be sorted numerically from 0 to 9.

Here’s an example of an alphabetic sort:
A. Claim received
B. Demand letter sent
C. Debtor called
D. Complaint filed
## Counties List

This window enables you to edit and view the list of counties and create new counties.

Counties may be optionally used as part of the address for debtors (on the Debtor Address window) and debtor’s employers. Counties can also be selected on the Court Tab for specifying the county in which a court is located. Only counties included in this list will be available for use in those addresses or on the Court Tab.

Totality ships with a list of several southern California counties. You are free to use, edit or delete these counties, and you may add the counties for the state(s) in which you work.
States/Provinces List

This window enables you to edit and view the list of states and provinces and create new states and provinces.

States and provinces are used as part of all the addresses in Totality, including the addresses for debtors, debtor employers, clients, creditors and attorneys. Only states and provinces included in this list will be available for use in those addresses.

Totality ships with a list of all the states and territories in the United States and all the provinces in Canada. You are free to use, edit or delete these counties, and you may add states and provinces for other countries.

NOTE: You may choose to edit the state and province names to change them to standard two-letter abbreviations (as seen in this screen shot). The main reason to consider making this change is if you prefer to have the two-letter abbreviations appear when you perform a mail merge. If you print envelopes or mailing labels using address data from Totality, they will contain whatever names or abbreviations appear in the States/Provinces list.
A list of the standard two-letter abbreviations for all the states, provinces and territories in the United States and Canada appears.

**Countries List**

This window enables you to edit and view the list of countries and create new countries.

Countries are used as part of all the addresses in Totality, including the addresses for debtors, debtor employers, clients, creditors and attorneys. Only countries included in this list will be available for use in those addresses.

Totality ships with a list of several countries. You are free to use, edit or delete these countries, and you may add any other countries you choose.

**NOTE:** You cannot delete or edit the listings for the United States and Canada because these are associated with the Mask Options.
Searching In Totality

You can search for Claims, Ticklers, Debtors, and Transactions. The following applies to searching for any of these:

Sorting

When you perform a search, the list of retrieved claims is initially sorted numerically by claim number (or alphabetically, if you use letters instead of numbers for the claim number). If you use Totality’s automatic claim numbering system, the most recently created claim will be last.

You can change the sort order by clicking on the headers immediately above the list of retrieved claims.

EXAMPLE: If you click on the Claim Number header, the list will be sorted in reverse numerical order by claim number, which means that the most recently created claim will be first (if you use Totality’s automatic claim numbering system).

If you click on the Debtor Name header, the list will be sorted in alphabetical order by debtor last name/company name. Click again, and it will sort in reverse alphabetical order.

Company Names

You can search for debtor company names by using either the Debtor Last Name or Debtor First Name fields. This will retrieve all claims where the name in the Company field (in the Debtors list) matches the specified name; this works for both individual and company debtors.
**Partial Names And Numbers**

You can search for all or part of any of the search criteria, and the criteria are not case sensitive.

For debtor, client and creditor names, you only need to enter the first few letters of the name you’re looking for.

EXAMPLE: As in the screen shot below, if you enter “mar” in the Debtor Last Name field, you will retrieve all debtors whose last name or company name begin with “Mar,” such as Martin, Martinez and Martin Marietta. (You will also retrieve all company debtors containing a name beginning with “mar” in the last name field. For company debtors, you can put the name of a contact person in the last and first name fields.)

For Social Security numbers and phone numbers, you can enter just a portion of the number and Totality will retrieve all claims matching that portion of the number.

EXAMPLE: If you enter “619” for the phone number area code, Totality will retrieve all claims where the phone number is in area code “619.”

**Phone Number Mask**

By default, there is a check mark in the Mask check box next to the Debtor Phone search criteria. This means you can only enter phone numbers using a standard North American format -- (XXX) XXX-XXXX—plus an optional extension.

If you remove the Mask check mark, then you can enter phone numbers of any format, which allows you to enter phone numbers for countries outside of North America.

**Search For Claims**

This window allows you to search for claims meeting specified criteria. You can access this window by the following methods:

- On the Navigator, click the Search for Claims button
• Click the “Search claims” icon on the toolbar (second icon from the left for single users, fourth icon from the left for network users)
• On the menu, select Activities, Search, Claims
• Press CTRL-L on the keyboard from anywhere in Totality

Search Criteria
You can search for claims meeting one or more of the following criteria:

• Debtor last name • Debtor Social Security number
• Debtor first name • Debtor phone number
• Company name • Client name
• Claim number • Creditor name
• Open claims • Closed claims

If you do not enter any search criteria, you will retrieve a list of all claims.
Search For Ticklers

The Search Ticklers window is automatically displayed when you start Totality if you have any uncompleted ticklers scheduled for today or any prior date. It can also be accessed by the following methods:

- Click the Ticklers button on the Navigator
- Click the Search Ticklers icon on the toolbar (seventh icon from the left for network users, fifth icon from the left for non-network users)
- Click the Activities menu, then select “Search” and then “Ticklers”
- Press Control-I from anywhere in Totality

See also:
Examples of how to use ticklers are on page 100.
Instructions on how to create a new tickler are on page 98.
Search For Debtors

This window allows you to search for debtors meeting specified criteria. You can access this window by the following methods:

- From the Debtors list, click the Search button on the bottom of the window
- On the menu, select Activities, Search, Debtors
- Press CTRL-D on the keyboard from anywhere in Totality

Search Criteria

You can search for debtors meeting one or more of the following criteria:

- Last name
- Social Security number
- First name
- Phone number
- Company name

If you do not enter any search criteria, you will retrieve a list of all debtors.
Search For Transactions

This window allows you to search for transactions meeting specified criteria. You can access this window by the following methods:

- On the menu, select Activities, Search, Transactions
- Press CTRL-T on the keyboard from anywhere in Totality

Search Criteria

You can search for transactions meeting one or more of the following criteria:

- Debtor last name
- Debtor first name
- Claim number
- Check number/notes
- Transaction date
- Transaction amount
- Transaction type
- Claim status (open, closed or all)

If you do not enter any search criteria, you will retrieve a list of all transactions.

![Search Transactions window]

96  Chapter 7  Searches  ABACUS TOTALITY Users Guide
Add New Tickler

Ticklers are essentially reminders to take some action with respect to an account. Examples of how ticklers can be used are on page 100. Ticklers are listed on the Search Ticklers window when you start Totality. Ticklers will continue to be listed when you start the program until you delete them, mark them as completed or change the date to a future date.

Creating Ticklers

Ticklers can be created in several ways:

- If you already have a claim open, click the New Tickler button to create a tickler for that claim.
- To create a tickler for a claim that is not open use one of the following methods:
  - Click on the Ticklers button on the Navigator and then click the New Tickler button.
  - Click the New Tickler icon on the toolbar (eighth icon from the left for network users, sixth icon from the left for non-network users)
  - Click the Activities menu, then select “New” and then “Tickler”
  - Press the F5 function key on the keyboard from anywhere in Totality
Automatic Ticklers
Ticklers can be automatically created when you make entries on the History Tab. For more information about creating History Actions that will generate automatic ticklers see page 86. Examples of how ticklers can be used are on page 100.
Instructions on how to create an entry on the History Tab are on page 62.

How To Create A New Tickler
You can create a new tickler from the Claim Details window of an open claim or from elsewhere in Totality.

From The Claim Details Window
1. Click the New Tickler button on the bottom of the Claim Details window. This opens the Add Tickler window.
2. The Debtor Name/Claim Number field will automatically contain the debtor name and claim number of the open claim. If you want to enter a transaction for a different claim, select the claim number/debtor name you want from the drop-down list.
3. Use the Tab key or the mouse to move to the Action field and enter the action you need to take on the claim. The Action is the description that will appear when the tickler is displayed on the Search Ticklers window.
4. Use the Tab key or the mouse to move to the Due Date field and enter the date you want the tickler to appear when you run Totality. For help with entering dates in Totality see page 41.
5. Use the Tab key or the mouse to move to the User field. This field will automatically contain the name you logged in with. (If you are not running Totality on a network then this field will contain “Single User”.)
NOTE: If you are running Totality on a network, you can change the user name to another user if you want the tickler to appear in their queue instead of yours. The ticklers will only appear when that user runs Totality on or after the tickler due date.

6. Click the Save button and then the Close button.

From Elsewhere In Totality

1. Open the Add Tickler window by one of the following methods:
   - Click the New Tickler icon on the toolbar (sixth icon from the left for single users, eighth icon from the left for network users)
   - Click the Ticklers button on the Navigator, and then click the New Tickler button
   - On the menu, select Activities, New, Tickler
   - Press the F5 function key on the keyboard from anywhere in Totality

2. In the Debtor Name/Claim Number field, select the claim number/debtor name for this tickler from the drop-down list. You can either click the drop-down arrow and select a claim from the list or you can start typing the last name or company name of the debtor.

3. Use the Tab key or the mouse to move to the Action field and enter the action you need to take on the claim. The Action is the description that will appear when the tickler is displayed on the Search Ticklers window.

4. Use the Tab key or the mouse to move to the Due Date field and enter the date you want the tickler to appear when you run Totality. For help with entering dates in Totality see page 41.

5. Use the Tab key or the mouse to move to the User field. This field will automatically contain the name you logged in with.
(If you are not running Totality on a network then this field will contain “Single User”.)

**NOTE:** If you are running Totality on a network, you can change the user name to another user if you want the tickler to appear in their queue instead of yours. The ticklers will only appear when that user runs Totality on or after the tickler due date.

6. Click the Save button and then the Close button.

**Tickler Details**

This window allows you to view and edit all the details of the open tickler.

**Tickler Examples**

If a debtor is scheduled to make periodic payments pursuant to a settlement agreement, schedule a tickler for the date the payment is due. If the payment is received, then change the tickler date to
the date of the next payment. If the payment is not received then follow up with the debtor.

Create a tickler when documents are sent to court or for service on a debtor as a reminder to follow-up after a specified period of time.

Create a tickler when a lawsuit is filed as a reminder that the debtor must be served within a specified period of time.

Ticklers can be used as a calendar of court appearances and other appointments. Ticklers can be scheduled in advance of the appearance or appointment to give you advance warning. If you have not yet filed suit, they can be used to calendar the statute of limitations on a claim.

**NOTE:** Although you can use Totality to calendar dates and other events, you should never rely upon a single system to keep track of critical events such as the expiration of statutes of limitation. Always use at least two different systems to calendar dates.

**Ticklers List (Summary Tab)**

This portion of the Summary Tab contains a list of all ticklers, completed and not completed, involving the open claim. You can sort the list by clicking on the various headers.

- Using the buttons to the right of the list, you can perform the following actions:
  - Click the Complete button to mark the highlighted tickler as complete.
  - Click the Details button to open the Tickler Details window, where you can edit all aspects of the highlighted tickler.
  - Click the Delete button to delete the highlighted tickler.
  - Click the Print button to print the tickler list.
Print Preview Window

When you display a report on-screen in preview mode you have a number of options. Using the icons on the preview toolbar, you can perform the following functions:

- Browse the pages of the report
- Set the zoom factor of the preview.
- Print the report to your printer
- Export the report in a variety of formats to a disk file
- Send the report in a variety of formats via e-mail (if your computer is configured for Microsoft Mail (MAPI))
- Change your printer setup
- Exit the preview screen.

Claim Report

This is a detailed printout of all information entered for a particular claim.

You can either view the Claim Report on-screen or print it to your printer, which provides a very useful hard copy that can be placed in the debtor’s paper file or sent to a client. You can specify which information will be included in the report.
NOTE: If you want an abridged report to submit to court or to send to a debtor, use the Statement of Account.

How To Print The Claim Report

1. Open the claim you want to print the Claim Report for.

2. Click the Reports button at the bottom of any of the Claim Details windows.

3. Click the Claim Report button, which opens the Claim Report Options window, where you can choose what data to include in the Claim Report. A check mark in the box next to the field name means that field will appear in your report. By default, all the fields are included. To exclude a field, click on it to remove the check mark.

4. Click the Print button to print the report on your printer, or click the Preview button to preview the report on-screen. For information about your options from the preview screen see page 103.

Claim Report Options

This window allows you to decide what information will be included in the Claim Report.

You can choose to include only certain fields in the Claim Report. A check mark in the box next to the field name means that field will appear in your report. By default, all the fields are included. To exclude a field, click on it to remove the check mark.
Statement Of Account

This is an abridged version of the Claim Report. The Statement of Account automatically appears on-screen in preview mode. To print it to your printer simply click the Print icon on the preview toolbar.

The Statement of Account is useful for sending to debtors and for submitting to courts in connection with debtor lawsuits. It lists all payment and cost transactions for a particular claim, including allocation between principal, interest and costs and a running outstanding balance.

How To Print The Statement Of Account

1. Open the claim you want to print the Statement of Account for.

2. Click the Reports button at the bottom of the Claim Details window.
3. Click the Statement of Account button.

The report will automatically appear on-screen in preview mode. To print the Statement of Account to your printer, click the printer icon on the preview toolbar.

**Reports Window**

This window enables you to produce three different reports: the Transaction Report, Payment Report and Tickler Report. Click the button for the report you want.

The Reports window is opened by clicking the Reports button on the Navigator.

When you click the Transaction or Payment Report buttons, the Report Options window opens. This allows you to decide what information will be included in the Transaction or Payment Reports.
Transaction Report

The Transaction Report is a detailed listing of all transactions that occurred during a specified period of time. It is similar to the Payment Report except that the Payment Report lists only payments whereas the Transaction Report lists both payment and cost transactions.

You can choose what data to include on the Transaction Report on the Transaction Report Options window, and you can choose which clients to include on the Report Client Selection window. The Transaction Report is sorted by client and then by claim, with sub-totals for each claim and client and totals for the entire report. Although most users will want to produce this report at the end of each month, it can be run at any time and can include all transactions for any date range.

The Transaction Report is printed from the Reports window.

How To Print The Transaction Report

1. You can print the Transaction Report by one of these methods:
   - On the toolbar, click on the Transaction Report icon (10th icon from the left for single users, 12th icon from the left for network users).
   - On the menu at the top of every screen, select “Reports” and then “Transaction Report.”
   - From the Navigator, click the Reports button, which opens the Reports window, and then click the Transaction Report button

2. You should now be looking at the Transaction Report Options window, which enables you to choose to include only certain fields in the report. A check mark in the box next to the field name means that field will appear in your report. By default, all the fields are included. To exclude a field, click on it to remove the check mark.
3. You must enter the beginning and ending dates for the report. The report will include all payment and cost transactions that occurred on and between these dates.

**NOTE:** Payments which are on Automatic Hold (held payments) will not appear on the Transaction Report, but the balances shown for any subsequent costs or payments for that claim on the report do reflect held payments. Held payments (normally personal checks) do not appear on the report because if they subsequently are returned for non-sufficient funds then the allocation of those payments would have to be reversed in a subsequent report.

4. Click the Print button to print the report on your printer, or click the Preview button to preview the report on-screen and see what your report will look like if you print it.

See also: For information about your options from the preview screen see page 103.

5. You should now be looking at the Report Client Selection window, which allows you to decide what clients will be included in the report. The Report Client Selection window looks like this:
6. Select the clients you want to appear in the report, and then click the OK button.

**NOTE:** All clients are selected when this window opens. To unselect certain clients, press and hold the Control key and click on the clients you want to unselect. Alternatively, click the Unselect All button and then Control-click on the client(s) you want to select.

7. If you selected to print the report on your printer, it will now print. If you selected to preview the report on-screen you will see what your report would look like if you printed it. For information about your options from the preview screen see page 103.

**Transaction/Payment Report Options**

This window opens when you run a Transaction or Payment Report. This window allows you to decide what information will be included in the Transaction or Payment Reports.

You must enter the beginning and ending dates for the report. The report will include all payment and cost transactions (for the Transaction Report) or all payment transactions (for the Payment Report) that occurred on and between these dates.

**NOTE:** Payments that are on Automatic Hold (held payments) will not appear on the report, but the balances shown
for any subsequent costs or payments on the report do reflect held payments.

You can choose to include only certain fields in a report. A check mark in the box next to the field name means that field will appear in your report. By default, all the fields are included. To exclude a field, click on it to remove the check mark.

![Image of Transaction Report Options]

**Report Client Selection Window**

This window opens when you run a Transaction or Payment Report. This window allows you to decide which clients will be included in the Transaction or Payment Reports.

You can choose to have claims for all, some or one client appear in the Transaction or Payment Report. By default, all the clients are included.

To exclude one or more clients, press the Control key and, while holding it down, click on the clients you want to exclude. To include the claims for just one client, click on that client.

**NOTE:** Clients will only appear in this window if they are associated with claims that contain transactions with
Payment Report

The Payment Report is a detailed listing of all payments that occurred during a specified period of time. It is similar to the Transaction Report except that the Payment Report lists only payments whereas the Transaction Report lists both payment and cost transactions.

You can choose what data to include on the Payment Report on the Payment Report Options window, and you can choose which clients to include on the Report Client Selection window.

The Payment Report is sorted by client and then by claim, with sub-totals for each claim and client and totals for the entire report. The Payment Report is printed from the Reports window.

How To Print The Payment Report

1. You can print the Payment Report by one of these methods:

   • On the toolbar, click on the Payment Report icon (11th icon from the left for single users, 13th icon from the left for network users).
• On the menu at the top of every screen, select “Reports” and then “Payment Report.”

• From the Navigator, click the Reports button, which opens the Reports window, and then click the Payment Report button.

2. You should now be looking at the Payment Report Options window, which enables you to choose to include only certain fields in the report. A check mark in the box next to the field name means that field will appear in your report. By default, all the fields are included. To exclude a field, click on it to remove the check mark.

3. You must enter the beginning and ending dates for the report. The report will include all payment and cost transactions that occurred on and between these dates.
NOTE: Payments which are on Automatic Hold (held payments) will not appear on the Payment Report, but the balances shown for any subsequent costs or payments for that claim on the report do reflect held payments. Held payments (normally personal checks) do not appear on the report because if they subsequently are returned for non-sufficient funds then the allocation of those payments would have to be reversed in a subsequent report.

4. Click the Print button to print the report on your printer, or click the Preview button to preview the report on-screen and see what your report will look like if you print it.

See also: For information about your options from the preview screen see page 103.

5. You should now be looking at the Report Client Selection window, which allows you to decide what clients will be included in the report. The Report Client Selection window looks like this:

![Report Client Selection Window]

6. Select the clients you want to appear in the report, and then click the OK button.

NOTE: All the clients are selected when this window opens. To unselect certain clients press and hold the Control key.
and click on the clients you want to unselect. Alternatively, click the Unselect All button and then Control-click on the client(s) you want to select.

7. If you selected to print the report on your printer, it will now print. If you selected to preview the report on-screen you will see what your report would look like if you printed it. For information about your options from the preview screen see page 103.

 Tickler Report

The Tickler Report prints a list of all the ticklers for every claim. This report includes both completed and uncompleted ticklers for all users and for both completed and uncompleted claims.

How To Print The Tickler Report

1. You can print the Tickler Report by one of these methods:
   • On the toolbar, click on the Tickler Report icon (12th icon from the left for single users, 14th icon from the left for network users).
   • On the menu at the top of every screen, select “Reports” and then “Tickler Report.”
   • From the Navigator, click the Reports button, which opens the Reports window, and then click the Tickler Report button
2. The Tickler Report will automatically open on-screen in preview mode. To print it to your printer, click the printer icon on the preview toolbar.

Other Reports Listing Ticklers

You can also print lists of ticklers from the Search Ticklers window, which has the additional feature to let you specify criteria for which ticklers to include in your search. The list you print will contain only the ticklers displayed on-screen at the time you click the Print button.
You can print lists of all ticklers for a particular claim from that claim’s Summary Tab. Click the Print button on the right side of the Summary Tab, next to the list of ticklers. More information is on page 101.

Exporting To Other Programs

The data exported by Totality’s mail merge function can also be opened in other programs, such as Microsoft Excel. This enables you to perform a variety of functions with your data, including sorting and generating your own custom reports.

See also:
For step-by-step instructions on how to export data to use in a mail merge see page 116.
For step-by-step instructions on how to perform a mail merge in Microsoft Word see page 118.
For step-by-step instructions on how to perform a mail merge in WordPerfect see page 117.
Mail Merge

The mail merge function allows you to export data from Totality to generate documents, such as demand letters and pleadings, in Microsoft Word, Corel WordPerfect and other programs. The Totality data is exported to an ASCII text file in comma delimited form, which can be used as a mail merge data (secondary) file by Word, WordPerfect and other programs.

How To Export Data To Use In A Mail Merge

To export Totality data, follow this procedure:

1. Open the Mail Merge window by one these methods:
   - From the Navigator, click the Mail Merge button.
   - From the toolbar, click the Mail Merge icon (fourth icon from the left for single users, sixth icon from the left for network users).
   - From the menu, click Activities and select “Mail Merge.”
   - From anywhere in Totality, press CTRL-M.

2. You will see a list of all the claims in the database, sorted alphabetically by debtor last name or company name. You can sort the claims by different criteria by clicking on any of the column headers; clicking once creates an ascending sort, and clicking a second time creates a descending sort.

3. Select the claim or claims you want to export by clicking on them. To select all the claims click the Select All button. To select multiple non-contiguous claims follow the instructions on the Mail Merge window.

4. When you have completed selecting claims, click the Export button.
5. The “Export Claim(s) to” dialog box appears. Specify a file name for the exported data (the default is “Totality 3 Merge.txt”), and select the folder in which you want the file to be saved (the default is the folder where Totality is installed, which is usually C:\Abacus Totality).

6. Run your word processor and perform a mail merge using “Totality 3 Merge.txt” (or whatever file name you chose) as the mail merge data file.

See also:
For step-by-step instructions on how to perform a mail merge in Microsoft Word see page 118.
For step-by-step instructions on how to perform a mail merge in WordPerfect see page 117.

How To Perform A WordPerfect Mail Merge

Performing a mail merge in WordPerfect 6.x, 7 and 8 is easy. Follow this procedure:

1. Export your Totality data. For help with this procedure see page 116.

2. Run WordPerfect.

3. Open the Totality export data file as follows:
   A. Click on the File menu and select the Open menu item.
   B. Switch to the folder where you exported the Totality data file (usually C:\Abacus Totality).
   C. Find and select the export file (usually “Totality 3 Merge.txt”).
   D. Click Open.
   E. The Convert File Format dialog box will appear. If it does not say “ASCII (DOS) Delimited Text,” then click on the down arrow and select “ASCII (DOS) Delimited Text.”
F. The Import Data dialog box appears.

G. Next to the “Import as:” label click on the double arrow and select “Merge Data File.”

H. Click OK.

4. Click on the File menu and select the Save As menu item.

5. Save the file with the name “Totality 3 Merge.DAT.” If the program asks if you want to delete the original file (usually named “Totality 3 Merge.txt”) click Yes. You can always create a new “Totality 3 Merge.txt” file by exporting again from Totality.

6. Click the “Go to Form” button on the toolbar.

7. If you want to work with an existing WordPerfect document, click Select and open the file you want to work with. If you want to create a new document, click Create.

8. When your new or existing document is on the screen, click on the “Insert Field” button. This will open the “Insert Field or Number” dialog box. You will see a list of field names, each one of which corresponds to a field in Totality.

9. You are now ready to create your document. Whenever you want to insert a data field from Totality, scroll to the field name you want and click the Insert button.

10. When your document is complete, click the Merge toolbar icon. The Perform Merge dialog box will appear. Select the options you want, and then click Merge.

11. When you view your merged document, the first page may contain just the field labels. If that is the case, simply delete the first page.

How To Perform A Microsoft Word Mail Merge

Performing a mail merge in Microsoft Word 95 or later is quite easy. Follow this procedure:
1. Export your Totality data. For help with this procedure see page 116.

2. Run Word.

3. Either create a new document or open an existing document that you want to merge with your Totality data. The existing document can have Totality merge fields, but it doesn’t have to because you can create merge fields later in this process.

4. Click on the Tools menu and select Mail Merge.

5. Under “1. Main Document,” click Create and select the Form Letters menu item (even if the document you are creating is not a letter).

6. If you have already opened the new or existing document you want to work with, click on Select Active Window. Otherwise, click on New Main Document.

7. Under “2. Data Source,” click Get Data and select the Open Data Source menu item.

8. The Open Data Source dialog box appears. Switch to the directory, or folder, where you exported the Totality data file (usually “Totality 3 Merge.txt” in C:\Abacus Totality).

9. Switch the “Files of Type” field to “Text Files (*.txt).”

10. Select the Totality data file (usually “Totality 3 Merge.txt”) and click Open.

   **NOTE: If you get an error message stating, “Can’t open data source” or “Word was unable to open the data source,” see page 121 for troubleshooting suggestions.**

11. Click Edit Main Document.

12. You are now ready to create your document. Whenever you want to insert a data field from Totality, click on the mail merge toolbar icon labeled “Insert Merge Field.” You will see a list of field names, each one of which corresponds to a field...
in Totality. If all the field names don’t fit on the screen, press ALT-SHIFT-F for a dialog box listing all the merge fields.

13. Clicking on the View Merged Data icon allows you to toggle between viewing the names of the data fields and the contents of the fields for the first record you exported.

14. When your document is complete, click the Merge toolbar icon or select Mail Merge from the Tools menu and follow the instructions in the Merge dialog box.
Solving Problems You May Encounter With Totality:

<table>
<thead>
<tr>
<th>Problem</th>
<th>Try this</th>
</tr>
</thead>
<tbody>
<tr>
<td>You run Totality and you can’t find data that you know should be in the database.</td>
<td>You may have opened the wrong database without realizing it. This can happen on a LAN if the network goes down, in which case Totality might try to find another database to open, such as a database on the local hard drive. Click the File menu and then “Open Database.” Find the drive and folder your database is in and open the database in that location.</td>
</tr>
<tr>
<td>You get a “Cannot Open Data Source” or “Word was unable to open the data source” error message when attempting to perform a mail merge in Microsoft Word.</td>
<td>This error means the data file created by Totality for merging with a Word form (template) cannot be opened. Unfortunately, Word will not tell you why it failed to open. 1. Click “Get Data” and select “Open Data Source.” The “Open Data Source” window opens for you to select the data file to be merged (step No. 8 in the instructions for performing a Word mail merge on page 118).  2. Find and click on your data file.  3. Make sure there is a check mark in the “Select method” box on the Open Data Source dialog box and then click the Open button.</td>
</tr>
</tbody>
</table>
4. If you get a Confirm Data Source dialog box, select “Text Files (*.txt)” as the open data source.

5. If you still get the data source error message, this is probably because you do not have all the Word text converters installed. To fix this, you need to reinstall Word and ensure that all the text converters are installed.

You search for ticklers but can’t find some ticklers that you know should be there.

This is probably because one or more of the search criteria do not match the “missing” ticklers:

1. On the Search Ticklers window, change the User field to “All Users.” Then click the Search button.

2. If your ticklers still do not appear, change the Completed field to “All.” Then click the Search button.

3. If your ticklers still do not appear, click the “All” dates radio button. Then click the Search button.

You are unable to see the entire Totality screen.

This is probably because the Windows Taskbar is blocking part of the screen.

1. If your Taskbar (usually at the bottom of your screen) is always visible, then it could be blocking part of the Totality screen:

   Right-click on a blank portion of the Windows Taskbar. Select Properties.

   Place a check mark next to “Auto hide” and remove the check mark next to “Always on top.”

   If this solves the problem, if you wish you can try either removing the check mark from “Auto hide” OR restoring the check mark to “Always on top.”
2. If this does not solve the problem you might need to increase your screen resolution (provided that your video card supports a higher resolution):

Right-click on a blank portion of the Windows desktop. Select Properties, which opens the Display Properties window.

Click on the Settings tab.

Under Desktop Area your screen resolution will be displayed. If it says 640 by 480 pixels then you can try increasing it to 800 x 600 by sliding the slide control to the right.

Click OK.

Technical Support

Our Technical Support staff is available to help you Monday through Friday from 9:00 AM to 5:00 PM Pacific time.

Before calling for service, you’ll save yourself time if you check the help file, including the Troubleshooting help page, to see if it contains the answer to your question. For how to use the help file see page 28.

You can also e-mail technical questions or program enhancement requests to:

support@TotalitySoftware.com

You must know certain information about your system for us to help you. When you call for technical support, please:

• Have the phone by the computer.
• Be ready to type commands.
• If you have a network, log in as “admin” and make sure you
  know any required passwords for unrestricted access to
  Totality’s database.
• Know what drive and subdirectory Totality is installed in, both
  on your computer and, if you have a network, on the server.

Technical support phone number:
(858) 536-8077
Network Installation

Dedicated Server Networks

How To Install Totality On A Network With A Dedicated Server

The following instructions are for installing Totality only on a dedicated server network. A dedicated server is a computer, usually running Windows NT 4.0 Server or Novell NetWare, which is dedicated to controlling the network. Do not use the dedicated server as a workstation for any users. All shared data files, such as the Totality database, are located on the dedicated server.

Installing Totality on a dedicated server network is a 3-step process:

First, enable sharing of the drive or folder where the Totality database will be located.

Second, from the workstations where Totality is to be installed, map the network drive or folder where the Totality database will be located.

Third, install Totality on each workstation, which will also install the database to the server.

Please follow these instructions carefully:
**A. Enable Sharing:**
To enable the workstations to access the Totality database you must have sharing enabled for the drive or folder on the server where the database will be located. This is necessary to allow your workstations to “share” the database with the server and with the other workstations.

If you already have sharing enabled for that drive or folder then you can proceed to the next step.

If you do not have sharing enabled, see page 128 for step-by-step instructions on how to enable sharing of your database folder. When you are done move to the next step.

**B. Map Server Database Drive Or Folder:**
The drive or folder where the Totality database will be installed on the server must be mapped on each of your workstations that will be running Totality. This is necessary to allow your workstations to access the network database on the server.

If you already have that drive or folder mapped on each of your workstations, then you can proceed to the next step.

If you do not have that drive or folder mapped on each of your workstations, see page 130 for step-by-step instructions on how to map the Totality database folder. When you are done move on to the next step.

**C. Install Totality On The Workstations:**
These instructions will install the Totality application (program) files on the local hard drive of each of the workstations and will install the Totality database on the server.

This procedure must be followed on each of the workstations that are going to run Totality.

1. Insert the Totality CD-ROM in the workstation CD-ROM drive and run SETUP.EXE. Follow the on-screen instructions.

2. When you reach the Where to Install Components window during setup, use the following settings:
A. The Application Folder (the folder where the Totality program will run from) should be on your local hard drive. We recommend accepting the default, C:\Abacus Totality.

B. The Database Folder (the folder where the Totality database will be located) must be the folder for which you previously enabled sharing in step A and that you mapped in step B. Normally, this will be “[Mapped drive letter]:\Totality Database.”

C. To specify the correct Database Folder, click the Browse button to open the Select Database Folder window. On the bottom, switch to the server drive letter where the database is to be installed. Then click on the database folder name (“Totality Database” by default) and click OK.

D. EXAMPLE: If you used the folder name we recommended, and if the G: drive is the drive containing the Totality database, then the Database Folder will be G:\Totality Database.

3. Complete the setup process.

4. Run Totality from this workstation. You should be prompted for a user name and password. If users have already been entered into Totality and you know your user name, then you can try entering a password that is the same as your user name. Otherwise, you can log in with user name “admin” and password “admin.”

**NOTE:** For information about entering users and changing and resetting passwords see page 11.

5. If the Database Folder was installed to the correct server folder in step No. 2 above, the program should automatically open to the shared database on the network server, and you are ready to begin working.

**NOTE:** You can confirm that the correct network database opened if you are able to view data that was previously
entered into the network database. If you are testing this on the first workstation on which Totality has been installed, enter some data and confirm that you can view that data from another workstation.

6. If a different database opens, such as a database on the workstation’s local hard drive, click the File menu and then Open Database, which opens the Open Database window. Switch to the drive and folder on the server where the network database is located, select the “Totality 3.0.mdb” file and click Open.

NOTE: You can only have one database open at a time.

7. When you subsequently run Totality, the program will automatically open to the same database you were running when you last exited Totality.

How To Enable Sharing On A Dedicated Server

To run Totality on a dedicated server network you must have sharing enabled either for the folder in which the Totality database is installed (“[drive letter]:\Totality Database” by default) or for the entire network drive on which the database is installed.

If you already have sharing enabled for the drive where the database will be located then you can return to the instructions for installing Totality on a dedicated server network.

The following instructions are for servers running NT 4.0 Server (SP4 or greater). To install on Novell NetWare servers you will need to use the NetWare equivalents to these instructions.

NOTE: These instructions explain how to share the Totality database folder. If you want to share the entire drive, substitute the drive letter for the folder name in these instructions.

1. Run Windows Explorer on your server.

2. On the drive where the Totality database will be located, create the folder where the database will be installed. We
suggest that you create a folder called “Totality Database.” If you are creating this folder on the C: drive, the recommended path would be C:\Totality Database.

**NOTE:** You may choose another folder name, but these instructions assume that you used the recommended folder name.

3. Right click on the database folder. This will bring up the right-click menu.

4. Select “Sharing . . .”, which opens the Properties window.

5. Use the following settings on the “Sharing” tab:
   
   A. “Shared As” radio button.
   
   B. Share Name: “Totality Database”

   **NOTE:** This name is recommended, but you can use other names, especially if you are sharing the entire drive rather than just the database folder. Whatever name
you select, make sure you make a note of it for future reference.

C. Comment: optional.

D. User Limit: Maximum Allowed

6. Click OK.

7. If you used a share name greater than eight characters, you may receive a message stating that the share name you selected is not accessible from some MS-DOS workstations and asking you to confirm the share name. That will not be a problem because Totality does not run on MS-DOS workstations, and so you can click Yes.

8. Sharing is now enabled. You can return to the instructions for installing Totality on a dedicated server network.

**How To Map The Totality Database Folder**

After you enabled sharing of the Totality database drive or folder on your network server, you must map that drive or folder on each of the workstations that will be running Totality. This is necessary so that you can access the network database from each of your workstations.

**NOTE:** Before mapping the database drive or folder you must determine the Computer Name of your server. If you do not know the Computer Name of your server, follow these instructions for a server running Windows:

9. Go to the server

10. Right click on the Network Neighborhood icon on the desktop

11. Select Properties

12. Go to the Identification tab.
13. Note the name in the Computer Name field and write it down. That is the name of your server.

Follow these instructions on each workstation where you do not already have that drive or folder mapped:

1. Run Windows Explorer.

2. Click on the Tools menu.

3. Select “Map Network Drive...” This will open the Map Network Drive window.

NOTE: The following screen shots show what the Map Network Drive window looks like, but the data in the screen shots may differ from what you see, depending upon what operating systems you are running and what Computer Name and folder names you are using. The data in the screen shots is from a network with an NT 4.0 server and a Windows 95 workstation.

In Windows 95 and 98, the Map Network Drive window looks like this:
14. Use the following settings, as illustrated in the above screen shots:

1. Drive: This should automatically configure to the next available drive letter, but you can specify a different available letter.
   
   1. Path: `\[Name of server]\[Share name for folder on server where Totality database is installed]`
   
   EXAMPLE: `\Pentium2\Totality Database`

   **NOTES:** “Name of server” is the server Computer Name that you wrote down above. “Share name” is the name that you used to identify the Totality database folder or server drive when you enabled sharing of that folder. We recommended “Totality Database” for an NT 4.0 server and “Totality” for a Windows 95 or 98 server.

2. Reconnect at logon: Check mark.

15. Click OK.
16. Mapping is now complete. You can return to the instructions for installing Totality on a peer-to-peer network or dedicated server network.

Peer-To-Peer Networks

How To Install Totality On A Peer-To-Peer Network

The following instructions are for installing Totality only on a peer-to-peer network where all of the connected computers are used as workstations but one computer holds shared data files. The computer holding the shared data files will be referred to as the “server.” The Totality database file will be located on the server.

17. Installing Totality on a peer-to-peer network is a 4-step process:

18. First, install Totality on the server.

19. Second, enable sharing of the server drive or folder where the Totality database is located.

20. Third, at each of the workstations where Totality is to be installed, map the server drive or folder where the Totality database is located.

21. Fourth, install Totality on each workstation.

Please follow these instructions carefully:

A. Install Totality On The Server:

This procedure must be followed on the computer on which the Totality database will be located for access by all the workstations. This computer will be referred to as the “server.”

NOTE: On a peer-to-peer network, you can run Totality on the server as well as on the workstations, and all the computers will access the same database, which is located on the server.

22. Insert the Totality CD-ROM in the CD-ROM drive and run SETUP.EXE. Follow the on-screen instructions.
23. When you reach the Where to Install Components window during setup, use the following settings:

   The Application Folder (the folder where the Totality program will run from) should be on your local hard drive. We recommend accepting the default, C:\Abacus Totality.

3. The Database Folder (the folder where the Totality database will be located) should be on your local hard drive. We recommend accepting the default, C:\Abacus Totality\Database.

24. Complete the setup process.

**B. Enable Sharing:**

To enable the workstations to access the Totality database you must have sharing enabled for the drive or folder on the server where the database is located (the default is C:\Abacus Totality\Database). This is necessary to allow your workstations to “share” the database with the server.

If you already have sharing enabled for that drive or folder then you can proceed to the next step.

If you do not have sharing enabled, see page 136 for step-by-step instructions on how to enable sharing of your database folder. When you are done move on to the next step.

**C. Map Server Database Drive Or Folder:**

The drive or folder where the Totality database was installed on the server must be mapped on each of your workstations that will be running Totality. This is necessary to allow your workstations to access the network database on the server.

If you already have that drive or folder mapped on each of your workstations, then you can proceed to the next step.

If you do not have that drive or folder mapped on each of your workstations, see page 130 for instructions on how to map the Totality database folder. When you are done move on to the next step.
D. Install Totality On The Workstations:
This procedure must be followed on each of the workstations that are going to run Totality.

25. Insert the Totality CD-ROM in the workstation CD-ROM drive and run SETUP.EXE. Follow the on-screen instructions.

26. When you reach the Where to Install Components window during setup, use the following settings:
   - The Application Folder (the folder where the Totality program will run from) should be on your local hard drive. We recommend accepting the default, C:\Abacus Totality.
   - The Database Folder (the folder where the Totality database is located) must be the folder for which you previously enabled sharing in step B and that you mapped in step C. Normally, this will be "[Mapped drive letter]\Abacus Totality\Database."

4. To specify the correct Database Folder, click the Browse button to open the Select Database Folder window. On the bottom, switch to the server drive letter where the database is to be installed. Then click on the database folder name ("Abacus Totality\Database" by default) and click OK.

6. EXAMPLE: If you used the folder name we recommended, and if the G: drive is the drive containing the Totality database, then the Database Folder will be G:\Abacus Totality\Database.

27. Complete the setup process.

28. Run Totality from each workstation. You should be prompted for a user name and password. If users have already been entered into Totality and you know your user name, then you can try entering a password that is the same as your user name. Otherwise, you can log in with user name “admin” and password “admin.” For information about entering users and changing and resetting passwords see page 11.

29. If the Database Folder was installed to the correct server folder in step No. 2 above, the program should automatically
open to the shared database on the network server, and you are ready to begin working.

NOTE: You can confirm that the correct network database opened if you are able to view data that was previously entered into the network database. If you are testing this before Totality has been run on the server for the first time, enter some data and confirm that you can view that data from another workstation or the server.

30. If a different database opens, such as a database on the workstation’s local hard drive, click the File menu and then Open Database, which opens the Open Database window. Switch to the drive and folder on the server where the network database is located, select the “Totality 3.0.mdb” file and click Open.

NOTE: You can only have one database open at a time.

31. When you subsequently run Totality, the program will automatically open to the same database you were running when you last exited Totality.

How To Enable Sharing On A Peer-To-Peer Server

To run Totality on a peer-to-peer network you must have sharing enabled either for the folder in which the Totality database is installed (“C:\Abacus Totality\Database” by default) or for the entire network drive on which the database is installed.

If you already have sharing enabled for the drive where the database will be located then you can return to the instructions for installing Totality on a peer-to-peer network on page 133.

The following instructions are for servers running Windows NT 4.0 (SP4 or greater), Windows 98 and Windows 95.

NOTE: These instructions explain how to share the Totality database folder. If you want to share the entire drive, substitute the drive letter for the folder name in these instructions.
Run Windows Explorer on your server.
Go to the drive and folder where the Totality database is installed. By default that is C:\Abacus Totality\Database.
Right click on the database folder. This will bring up the right-click menu.
Select “Sharing . . .”, which opens the Properties window.

Use the following settings on the “Sharing” tab:
“Shared As” radio button.
Share Name:
Windows NT: “Totality Database”
Windows 95/98: “Totality”

**NOTE: These names are recommended, but you can use other names, especially if you are sharing the entire drive rather than just the database folder. Whatever name you select, make sure you make a note of it for future reference.**

Comment: optional.
User Limit (NT only): Maximum Allowed
Access Type (Win95/98 only): Full
Click OK.
If you used a share name greater than eight characters, you may receive a message stating that the share name you selected is not accessible from some MS-DOS workstations and asking you to confirm the share name. That will not be a problem because Totality does not run on MS-DOS workstations, and so you can click Yes.
Sharing is now enabled. You can return to the instructions for installing Totality on a peer-to-peer network on page 133.

Upgrade To Network Version

Upgrade To Network Version
If you own the single user version of Totality or Totality Lite, you can upgrade at any time to the network version by contacting Totality Software, Inc. for new registration codes.
If you do upgrade, you will need to follow one of the following two procedures, depending upon whether or not the computer on which you had been running Totality (“the original workstation”) will continue to hold the database file that will be shared by all the users on the network. The computer on which the database file is located will be referred to as the “server.”
If the original workstation will be the server on a peer-to-peer network the instructions are below.
If another computer will be the server on either a dedicated server or peer-to-peer network the instructions are on page 142.

Upgrade To Network Version With The Original Workstation As The Server
Follow this 4-step procedure to upgrade from the single user to network version of Totality when the computer on which you had
been running Totality (“the original workstation”) will act as the server on a peer-to-peer network.

32. First, enter the new registration codes on the server.

33. Second, enable sharing of the server drive or folder where the Totality database is located.

34. Third, at each of the other workstations where Totality is to be installed, map the server drive or folder where the Totality database is located.

35. Fourth, install and run Totality on each of the other workstations.

Please follow these instructions carefully:

A. **Enter The Upgrade Registration Codes:**

36. Run Totality on the server, which is the computer on which you were running Totality prior to your upgrade.

37. Enter your upgrade registration codes. For step-by-step instructions on how to obtain and enter the upgrade registration codes see page 13.

38. After you have successfully entered the upgrade registration codes, you may want to open the Users window and enter the names and user names of the people who will be running Totality. For more information about the Users window see page 11.

**NOTE: This does not have to be done at this stage, but we recommend completing this task now so that the new users can log in as soon as they have installed and run Totality on their workstations.**

B. **Enable Sharing:**

To enable the workstations to access the Totality database you must have sharing enabled for the drive or folder on the server where the database is located (the default is C:\Abacus
Totality\Database). This is necessary to allow your workstations to “share” the database with the server.

If you already have sharing enabled for that drive or folder then you can proceed to the next step.

If you do not have sharing enabled, see page 136 for instructions on how to enable sharing of your database folder. When you are done move on to the next step.

C. Map Server Database Drive Or Folder:

The drive or folder where the Totality database is installed on the server must be mapped on each of your workstations that will be running Totality. This is necessary to allow your workstations to access the network database on the server.

If you already have that drive or folder mapped on each of your workstations, then you can proceed to the next step.

If you do not have that drive or folder mapped on each of your workstations, see page 130 for instructions on how to map the Totality database folder. When you are done move on to the next step.

D. Install Totality On The Workstations:

This procedure must be followed on each of the new workstations that are going to run Totality.

39. Insert the Totality CD-ROM in the workstation CD-ROM drive and run SETUP.EXE. Follow the on-screen instructions.

40. When you reach the Where to Install Components window during setup, use the following settings:

   The Application Folder (the folder where the Totality program will run from) should be on your local hard drive. We recommend accepting the default, C:\Abacus Totality.

   The Database Folder (the folder where the Totality database is located) must be the folder for which you previously enabled sharing in step B and that you mapped in step C. Normally, this will be “[Mapped drive letter]:\Abacus Totality\Database.”
8. To specify the correct Database Folder, click the Browse button to open the Select Database Folder window. On the bottom, switch to the server drive letter where the database is to be installed. Then click on the database folder name ("Abacus Totality\Database" by default) and click OK.

9. EXAMPLE: If you used the folder name we recommended, and if the G: drive is the drive containing the Totality database, then the Database Folder will be G:\Abacus Totality\Database.

41. Complete the setup process.

42. Run Totality. You should be prompted for a user name and password. If users have already been entered into Totality and you know your user name, then you can try entering a password that is the same as your user name. Otherwise, you can log in with user name “admin” and password “admin.” For information about entering users and changing and resetting passwords see page 11.

43. If the Database Folder was installed to the correct server folder in step No. 2 above, the program should automatically open to the shared database on the network server, and you are ready to begin working.

NOTE: You can confirm that the correct network database opened if you are able to view data that was previously entered into the network database. If you are testing this before Totality has been run on the server for the first time, enter some data and confirm that you can view that data from another workstation or the server.

44. If a different database opens, such as a database on the workstation’s local hard drive, click the File menu and then Open Database, which opens the Open Database window. Switch to the drive and folder on the server where the network database is located, select the “Totality 3.0.mdb” file and click Open.

NOTE: You can only have one database open at a time.
45. When you subsequently run Totality, the program will automatically open to the same database you were running when you last exited Totality.

46. Repeat this procedure (step D) on each of your new workstations.

**Upgrade To Network Version With A Different Computer As The Server**

Follow this 3-step procedure to upgrade from the single user to Network version of Totality when the computer on which you had Been running Totality (“the original workstation”) will NOT be the server on a peer-to-peer or dedicated server network.

47. First, follow the standard network installation procedure for the server and new workstations.

48. Second, copy the database file from the original workstation to the server.

49. Third, configure the original workstation by joining the network group, entering the upgrade registration codes and opening the network database.

Please follow these instructions carefully:

**A. Install Totality On The Server And New Workstations:**

Totality can be installed on two different types of local area networks (LANs) -- networks using a dedicated server (which is not used as a workstation) and peer-to-peer networks where all of the connected computers are used as workstations but one computer holds shared data files.

The installation procedure for the two different types of networks is different. Be sure to use the correct procedure for your type of network.

**NOTE:** You will NOT be reinstalling Totality on the original workstation. You need to install Totality on the server and new workstations before you make the necessary
changes on the original workstation, as described in the subsequent steps below.

For step-by-step instructions on installing Totality on a dedicated server network, such as Windows NT 4.0 Server or Novell NetWare, see page 125.

For step-by-step instructions on installing Totality on a peer-to-peer network, such as Windows NT 4.0 Workstation, Windows 98 or Windows 95, see page 133.

B. Copy The Database To The Server:
You probably will want to continue working with the database you have been using on your original workstation. If you want your network users to work on a new database then skip this step and proceed to the next step.

50. Your current database file is located on your original workstation. Unless you changed its default name and location, it is named “Totality 3.0.MDB” and is located in the C:\Abacus Totality\Database folder.

51. Using Windows Explorer or any other file manager, copy your current database from the original workstation to the Database Folder on your server. The Database Folder is the folder on the server where the database is located. You selected the Database Folder during the installation process on your new workstations.

52. If you are running a dedicated server network, the recommended name was “Totality Database.”

53. If you are running a peer-to-peer network, the recommended name was “Abacus Totality\Database.”

NOTE: You will probably get a message asking if you want to overwrite the existing (blank) database. Answer Yes.
C. Configure The Original Workstation:

54. At the original workstation, run Totality and click the Register/Upgrade button on the Navigator, which opens Register/Upgrade window.

55. Click the Join Network Group button. This opens the Select Network Group dialog box.

56. Select the Database Folder where the Totality database is installed on the server and select the SemphHub.exe file in that folder. Then click the Open button. You will be returned to the Navigator.

57. Click the Register/Upgrade button on the Navigator again, which opens Register/Upgrade window.

58. If you have not already done so, contact Totality Software, Inc. to obtain your upgrade registration codes. Either call (858) 536-8077 or send an e-mail to support@TotalitySoftware.com.

59. Tell the representative or include in your e-mail the Code Entry Number and Computer ID displayed in the Register/Upgrade window.

60. You will be given a Trigger Code and an Additional Number. Enter those in the corresponding fields on the Register/Upgrade window.

61. Click the Enter Registration Codes button to complete your registration or upgrade, which should return you to the Navigator. If you decide not to complete the registration/upgrade process, click the Close Without Changes button.

62. The final step is to switch the original workstation from the database it had been running on the local hard drive to the network database on the server:

63. Click the File menu and select “Open Database.”
64. Switch to the drive and folder on the server where the Database Folder is located.
65. Select the Totality 3.0.MDB file.
66. Click the Open button.

To confirm what version of Totality you currently have registered or the number of network licenses you have available, click the Help menu and then select “About Abacus Totality.” The About Totality window should say “Totality for Local Area Networks” in large bold letters, and just above that it should tell you the number of “LAN Licenses” you are authorized and the number of “Current LAN Users.”

67. If, instead, the About Totality window says “Totality (TRIAL MODE),” you are not correctly registered or configured. Try repeating step C one more time.

68. After you have successfully entered the upgrade registration codes, you may want to open the Users window and enter the names and user names of the people who will be running Totality. For more information about the Users window see page 11.

**Upgrading Totality 2.1 Database to 3.0**

The Totality database converter converts your Totality 2.1 database to the Totality 3.0 format. If you have a version of Totality prior to 2.1 you must use the Totality 2.1 data converter first.

If you have already entered any data in your Totality 3.0 database, you should also make a backup of your 3.0 database because it will be overwritten by your converted 2.1 data.

To convert your database:

- Click the **Start** Menu button and Select Programs\Abacus Totality 3.0\Database converter. The database conversion program will appear.
69. A message will appear asking if you want to abort. Please read this carefully and Click **No** if you wish to continue. The Totality 3.0 conversion wizard appears.

70. Click **Next**. The Totality 2.1 database selection page appears.

71. Click **Browse** to select the 2.1 database you wish to convert (totdata.mdb). Click **Next**. The Totality 3.0 database selection page appears.

72. Click **Browse** to select the 3.0 database that you wish to put your data in (Totality 3.0.mdb). Click **Next**. The final page appears.

73. Click **Ok** to begin the conversion process.
Index

360-day calculation option, 25
365-day calculation option, 25
366-day calculation option, 25
Account, 125
  Statement of, 125
Add, 82, 115
  Tickler, 115
Address, 92
  Debtor, 92
Allocation method, 47, 48
  How to change, 48
Amount, 51
  Judgment, 51
Archive claims, 100
Assets, 93
Attorney, 52
  Remarks, 52
Attorneys, 99
  List, 99
Automatic hold, 49
  How to create, 87
Auxiliary, 81
  Claim Information, 81
Backup database, 38
Button, 88, 122
  NSF, 88, 89
  Print lists, 122
Calculation options, 25
Calendar, 54
Claim, 73, 74, 75, 108, 111, 123, 124
  How to create, 74
  New, 73
  Report, 123
  Report - how to print, 123
  Search, 110
Client
  Contingency fee, 97
  Remarks, 52
  Selection - reports, 133
Client:, 52, 97, 133
Clients, 95, 96
  List, 95, 96
Closed claims, 101
Codes, 17, 18, 100, 101
  Registration, 17, 18
  Status - how to create, 101
  Status - list, 100
Collection agency user type, 23
Compact database, 38
Contact information, iii
Contingency fees, 23, 45, 97
  Clients list, 97
  How to change, 46
  Overview, 44
Corel WordPerfect mail merge, 143
Counties, 105
  List, 105
Countries, 106, 107
  List, 106, 107
Court, 52, 80
  Remarks, 52
  Tab, 80

ABACUS TOTALITY Users Guide   Chapter 13 Index   147
Creditor, 52
   Remarks, 52
Creditors, 97
   List, 98
Database, 38, 39
   Backup, 39
   Compact, 38, 39
   Repair, 38, 39
Date, 50, 51
   Interest Start, 50
   Judgment Entered, 51
Dates, 53
   Working with and entering, 53
Debtor, 52, 92, 93, 94, 95
   Address, 92
   Assets, 93
   Employers, 94
   Remarks, 52
   Search, 112
Debtors, 90
   List, 91
Dedicated server network Installation, 152
Default, 21, 22
   Contingency fee, 22
Drop-down list, 53
E-mail, 122
   Send report via, 122
Employers, 94, 95
   Debtor, 94
Examples
   Tickler, 119
Export
   Reports, 122
Export:, 122
File utilities, 38
Financials Tab, 79
General Tab, 76
Header

Report, 21
History
   Actions list, 103
   Tab, 77
   How to create an entry, 78
History:, 76, 78, 103
Hold, 49, 50, 87
   How to create, 87
   Payments, 49, 50
Hot keys, 34
How Do I?, 13, 46, 48, 74, 78, 82, 87, 101, 116, 123, 126, 128, 135, 139, 141, 143, 145, 156, 167
Add actions taken on History Tab, 78
Change allocation method, 48
Change contingency fee, 46
Create automatic hold, 87
Create History Tab entry, 78
Create new claim, 74
Create new status code, 101
Create new tickler, 116
Create new transaction, 82
Install Totality on network - overview, 13
Mail Merge, 141, 142
Perform Word mail merge, 145
Perform WordPerfect mail merge, 143
Print Claim Report, 123
Print Payment Report, 135
Print Statement of Account, 126
Print Tickler Report, 139
Print Transaction Report, 128
Register, 17, 20
Share database - dedicated server, 156
Share database - peer-to-peer network, 167
Claim - options window, 124
Header, 21
Payment, 135
Payment - how to print, 135
Statement of Account, 125
Statement of Account - how to print, 126
Tickler - how to print, 139
Transaction, 128
Transaction - how to print, 128
Reports, 127
Window, 127
Search, 108, 109, 110, 111, 112, 113, 114
Claims, 108, 109, 110, 111
Debtors, 112, 113
Ticklers, 111, 112
Transactions, 113
Server, 152, 153, 154, 155, 156, 163, 164, 165, 166, 167
Dedicated - network installation, 152
Peer-to-peer - network installation, 162
Sharing, 156, 158, 159, 167, 169, 170
Database - dedicated server, 156
Database - peer-to-peer network, 167
Shortcut keys, 36
Single user installation, 12
Single user or network, 23
Statement of Account, 125
How to print, 126
States/Provinces, 106
List, 105, 106
Status codes, 100, 101, 102
How to create, 101
List, 100
Summary Tab, 75
Ticklers list, 120
Support, 150, 151
  Technical, 150, 151
Technical support, iii, 150
Tickler, 115, 116, 117, 118, 119, 120,
  121, 139
  Add, 115
  Details, 119
  Examples, 119
  How to create new, 116
  List - Summary Tab, 120
  New, 115
  Report - how to print, 139
  Search, 111
Toolbar, 31, 32, 33
Transaction
  Add, 82
  New, 82
  Report, 128
  Report - client selection, 133
  Report - how to print, 128
  Report - options, 132
Search, 113
Transaction Types, 86, 87
  List, 86, 87
Transaction:, 82, 113, 128, 132, 133
Transactions, 113, 114
  Search, 113
Troubleshooting, 147
Tutorial, 56, 72
Upgrade, 170, 171, 172, 176, 178,
  179, 180
  Network - server is original
    workstation, 171, 176
    To network version, 170
User, 23
  Type, 23
Users, 14, 15, 16
  Window, 14, 15
Welcome, 7
What’s new in Totality 3.0?, 1
Word mail merge, 145
Zip code option, 27